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1 INTRODUCTION
This guide is intended for teachers of Moodle courses and is mainly based on
contextual help available within the e-learning platform.

1.1 WHAT IS MOODLE
Moodle is an LMS (Learning Management System), a system for managing online
courses designed to create virtual classes that allow effective and engaging online
learning experiences. It is used internationally for educational and training projects
that involve the active involvement of learners and allow collaborative learning,
group work and knowledge exchange.

1.2 DEFINITION OF A MOODLE COURSE
The term Course means the virtual space dedicated to loading and managing the
teaching material of each individual teaching.
In the e-learning platform of the TRAPP Project the courses are set up according
to the format for topics, which allows to divide the material organizing it
according to the themes chosen by the teacher.
With Moodle you can: publish educational materials; develop, plan and manage
different types of evaluation activities; manage communications with users.

1.3.1

Design a course with Moodle
Before starting, it is good to have in mind the results you want to
achieve.
It seems a trivial question, but only by setting the educational objectives
exactly can you choose the best tools to reach them and create a
suitable path with Moodle.
One of the best ways to start building the course is to think about what
students

should

be

able

to

do

at

the

end

and

how

they

can

demonstrate the skills they have acquired.
The results of the learning must be established. These refer not only to
the content included in the course, but also to the skills, competences,
skills

acquired

and

the

level

of

trust

achieved.
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It is important to establish them at the start because, based on these,
every aspect of the course is modelled, from the choice of contents and
activities, to the evaluation planning that will decide whether the learning
path has been effective.
The first thing to do when starting to plan a course is to draw up a list
with the goals to be achieved.

1.2.2 Choose resources and activities
Once the educational objectives have been defined, the actual
creation of the course on Moodle can be started. We must not forget
to understand:
 A summary of each topic, inserted in the global framework of
the course
 Resources, such as text, video, audio, with the course contents
 Activities to put the acquired knowledge into practice and
consolidate the competences in view of the evaluation.

1.2.3 Evaluations
Moodle offers several tools that allow the student to demonstrate
what he has learned and what learning objectives he has achieved at
the end of the learning path.
Having clearly understood the educational objectives, and how the
acquired skills must be demonstrated, it will be easier to choose the
best tools for evaluation. Here are some guidelines to follow.
 The verification of each topic must be strictly linked to the
learning results of the section to which it refers.
 The test must be sufficiently complex to allow the student to
demonstrate the acquired skills.
 All the resources and activities present must be connected both to
the didactic objectives and to the evaluation.
 If there is a final evaluation of the course, this must include all
the learning outcomes of the course.
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After choosing the evaluation strategy, you can bring to enter quizzes
and tests within the course topics.
The instructions for the performance must be clear, as well as the
distribution of the scores so that the students develop greater selfesteem, it is important that the course contains:
 Evaluation activities, such as quizzes, interactive tests, multiple
choice questions, etc…
 Badges and Moodle certificates that encourage the student to
reach the goals for tape.

1.3 MOODLE ADMINISTRATOR
Although our role is not that of Moodle administrators, it is good to have an idea
of what the administrator has to do.
The duties of the administrator include the management of courses and roles.
This means which creates the courses that make up the platform and defines the
common settings; credits users to the site by providing them with login credentials
and assigns each user a role, a set of permissions that govern what they can do
and see within Moodle

1.4 ROLES
A role is a set of privileges defined at the site level. The role can be assigned to
users in specific contexts (category of courses, individual courses, activities, etc.).
This means, for example, that a user can have the role of Student within a
course, but more privileges in another course or within a specific discussion
forum.
Starting from the predefined ones, for specific needs (monitoring, evaluation, etc.)
custom roles can be created.
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ROLES

DESCRIPTION

MANAGER

Manager can access and modify courses but generally do
not participate in them.

COURSE CREATOR

Course creators can create new courses.

TEACHER

The teachers have
including changing
students

NON EDITOR
TEACHER

Non editor teachers can teach in courses and evaluated
students, but they can not change activities.

STUDENT

Students within a course usually have limited privileges and
can only use the resources/activities made available the
teacher.

GUEST

Guests have minimum privileges and can not normally
participate in activities has minimum privileges and can only
consult of the courses to which the access to the guests
has been constituted.

AUTHENTICATED USER

All authenticated users who have logged it.

unlimited power within the courses
activities/resources and evaluating
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2. BASIC INFORMATION
2.1. ACCESS TO THE PLATFORM E-LEARNING
First the platform administration must register and send you the login credentials
(username and password).
To connect to the project's e-learning platform, simply type in any web browser,
link

To

https://learning.europeanregisterphlebologists.eu/

log

in,

enter

your

details

in

the

Login

block

at

the

top

right.

When you first log in, the system may ask you to change the password. A box
will appear in which to type the password with which you have logged in and the
one you will use from the next login.

Logout procedure
To log out always click on the link (Exit) next to your name and last name; avoid
closing the browser window without logging out first.
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On first access, you will access a page with this content.

Edit profile.
A first aspect not to be
overlooked is that of the
profile that allows some
important

operations

to

be carried out.
Access to these features
can be done via the link
at the top right.
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2.2 BLOCKS
Personalization Work environment.
The teacher can customize his main page and the course page by activating a
series of blocks to be placed in the side columns.
The blocks can be placed in the right column. If a column does not have any
block, it is not displayed on the main page of the course.

Blocks can be added, hidden, deleted, and moved up, down and left / right when
write mode is activated.
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BLOCK

DESCRIPTION

ADMINISTRATION

It allows you to view different functionalities depending on
the role with which you are enrolled in the course.
The teacher will visualize the tools for the management of
the course, the registration of the participants, the
uploading of the files, etc.
The participant, on the other hand, links to his profile and
to his own assessment page.

ACTIVITIES

List of activities present in the course from which you can
access a page dedicated to each type of activity (for
example all the discussion forums activated in a course).

RECENT ACTIVITIES

All the changes of a course are displayed, starting from the
user's last access (for example the last discussions of the
forums, the updating of resources, the addition of
activities).

CALENDAR

A calendar of course events. Very useful especially to signal
the activities foreseen by a training course, deadlines, etc.

COURSES

List of courses you are enrolled in, very useful especially if
you have to manage many.

DESCRIPTION OF THE
COURSE / SITE

A box that displays the description of the course. It can
also contain hypertext links, images and formatting
elements (bold, italics, etc.).

HTML

A free HTML block that allows you to insert any element,
from images to links, from tables to videos.

PEOPLE

Link to the list of participants enrolled in the course from
which each user's profile can be accessed.

UPCOMING EVENTS

List of scheduled events starting from the current date. The
user can decide to customize the number of events to be
displayed.

SEARCH IN THE
FORUM

It allows you to search through discussion forum messages
through a simple or advanced search.

THE LATEST NEWS

Allows you to view the latest posts published in the
news forum

CONNECTED USERS

List of users simultaneously connected to the e
learning platform in the last 5 minutes. It can be a
useful motion above all if the course sees
synchronous activities like a chat.

VOICE AT RANDOM OF
GLOSSARY

Allows you to view a random term chosen from the
glossaries in the course.
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Add a block
>Add a block (right column, block at the
bottom of the page)
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3 COURSE SETTING AND MANAGEMENT
The course is created by the portal administrator or the person in charge of
creating courses.
The course "PHLEBOLOGY TRAINING COURSE" was organized by topic.
The arguments represent logical units into which the course can be divided.
However, the teacher has the possibility to change all the settings.

3.1 COURSE SCREEN.
The course screen is divided into 2 columns, it can change the arrangement of
the blocks that make up the right column.
The arrangement and modification of the Blocks, like any other modification (ex
insertion of resources, activities, etc.) is ALWAYS made by clicking on the “TURN
EDITING ON” button.
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In the left column you can see a certain number of "rectangles", all of them
numbered except the first one. These "boxes" represent the modules / sections or
macro-topics in which the course can be logically subdivided, while the first, not
numbered, is thought of as a "container" of general information or as an
introduction to the course.
The main difference in the visualization of a teacher / student side course is that
in the first one the "Turn editing on" button is always visible in the upper right
corner, while in the second one only the blocks of the right column and the left
column are visible without any possibility to modify the contents.
Once the "Turn editing on" button is activated, it changes to "Turn editing off"
and will have to be pressed at the end of entering the course changes.

The icons
By clicking on the "Turn editing on" button, a series of icons to be used to
modify, move, add and configure all aspects of the course appear at the interface
level, and next to each editable object.
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Meaning of the icons
the pencil icon allows you to edit inline the
title of the resource / activity
this icon groups actions together for easier
editing on smaller screens. Click to reveal the
options.

the move icon allows you to move items or
sections by dragging and dropping. (If you have
many activities to scroll through while moving,
see the Tips and Tricks section below for a
useful suggestion.)
this move icon appears if you don't have Ajax
enabled
he groups icon allows you to change between
no groups or separate/visible groups
the move here icon appears when moving a
course element without Ajax. Click into the box
to re-locate your item.
the up/down arrows allow you to move course
sections up or down and appear if you do not
have Ajax enabled.
allows you to set activities / resources using
the tools that Moodle makes available
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3.2 HOW TO SET THE COURSE
To access the course settings screen, simply click on "Course administration" by
the Administration block.
The general course settings are preset parameters by the platform administrator
that can be modified according to the specific needs of the teacher.
For example, you can change the number of topics in the column Left and set a
summary or summary of the course that will be displayed in the list of available
courses.
In addition, an enrollment key can be set for the course that is requested at
time of access to the course. In this way the student who does not know the
access key cannot enroll in the course.
Courses Administration -> Edit setting
The features contained in the Settings menu provide the possibility to modify and
customize the appearance of the course: a first window is the one

General Settings
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Course Title
The course title is displayed at the top of the course pages and in the course
list.

Short Title
Many institutions assign abbreviations such as BP102 or COMMS to the courses. If
you want you can use these abbreviations as a shortened title, otherwise you can
use any title you like. The abbreviated title will be used in place of the course
title in all those situations where it is practical to use shorter strings of
characters, such as bread crumbs or email headers.

Course Category
The website administrator should have prepared different categories of courses.
For example, "Occupational safety in upper secondary school", "Occupational
safety in lower secondary school", etc.
Choose the category that you consider most suitable for your course: as the
course title will appear in the category, an appropriate choice will make it easier
for students to find your course.
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Visibility
The settings determines the visibility of the course in the list of courses.
Administrators and teachers can still access it, while other users will not be able
to access the course.

Course Start Date.
The setting establishes the beginning of the first week in weekly format courses.
The setting also establishes the date from which the course activity logs start.

Course Id Number
The ID number of course is used when you interface Moodle to external systems
and it is never displayed inside Moodle if you know the ID number of the course,
you can insert in this field, otherwise you can leave it empty.

Introduction To The Course
The introduction will appear in the list of courses and will also be used to search
for courses.

Course Introduction File.
The course introduction files are displayed in the course list together with the
introduction.

Course Format
The choice of format is a delicate choice and must be consistent with the
organization of the course. The format refers to the structure of the page and of
the sections in which to insert the material. You can choose between:
•

Single Activity: a single resource or activity will be displayed (for example, a
SCORM package or a Quiz)

•

Relational: this format focuses on the relational forum, which will appear in
the central area of the main course page. This format, ideal for informal
situations, can also be used effectively for non-training activities or to
create notice boards

•

For Topics: the central body of the main page of the course is organized in
sections, each of which represents a topic of the course. Each section can
contain resources and activities.
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Weekly: The central body of the main page of the course is organized in
sections, each of which represents a week of course with a start date and
an end date. Each week may contain resources and activities.

For university courses, the subject format or weekly format is generally chosen;
for example for a semester course, lasting 12 weeks, it can be convenient to
choose the weekly format. When the duration of the course is not significant, it
can be organized by topic.

Hidden Sections
The setting determines how the hidden sections are displayed to students.
During the creation of the course it is possible to decide when to make each
section visible to the students. We can hide, for example, topics that have not yet
been treated, or material that we want to make available only after a certain
moment, or material that is not yet definitive. With this setting it is established
how to treat all the hidden sections: they can be completely invisible, or you can
only view the title (for example, for a week holiday or an untreated topic).

Course Display
It allows you to set the way in which the sections of the course will be displayed,
all on the same page or spread over several pages. The setting has no effect on
some types of formats, such as the SCORM format.
When each section covers different topics, displaying one per page can make the
course less confusing. In this case on the first page there will be only the list of
the various topics or weeks, the content of the section is accessed by clicking on
the title. The introduction to the course is always displayed in each topic; two
arrows at the top and bottom of the page allow the passage from one section to
the previous or the next one.

Number of News to display
In courses that use the "weekly format" and the "format for topics", there is a
default forum called "Forum News". This forum is useful for communicating
information and news about the course to students. (By default all students are
automatically enrolled in this forum and will receive in their email inbox any
postings made in the forum itself).
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The Number of news to be displayed determines the number of last news to be
presented on the main page of the course, in the block called "Latest news".
If "News to display" is set to "0", the "Latest news" block will not be visible on
the main page of the course.

View student ratings
Many of the activities of a course can be evaluated.
By default, the results obtained by the students are displayed on the Evaluations
page, which can be reached directly from the main course page.
If a teacher is not interested in using the assessments or if you want to prevent
students from accessing the page containing the results obtained, simply set "View
student ratings" to "No". Setting to "No" does not prevent you from evaluating
course activities, it only prevents students from viewing them.

View activity reports
The reports of the activities carried out in the course are available for each
participant.
In the reports, in addition to the list of activities performed, there is also the
access log. This setting determines whether a student can view their reports from
the personal profile page.

File and upload
Maximum size of uploadable files.
This setting determines the maximum file size that students and teachers can
upload. The setting only affects the files that can be loaded within the course
and is in turn limited to its maximum value by the similar setting made at the
site level by the System Administrators.
It is also possible to further limit the maximum size of the uploadable files for
each course activity.

Completion tracking
Track completion
Enable the tracking capabilities for course and activity completion.
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Guest Access
Allow access to guest
The setting determines whether a user can access a course as a guest, without
being registered.

Key
A key restricts access to only those guests who have one. Guests will need to
enter the key each time they enter the course.

GROUPS
Group Mode
The setting has three options:
 Without Groups - Group mode is not active, each participant is part of the
same community.
 Separate Groups - Each participant is a member of the group to which he
has been assigned, he is not able to see the work done by the members of
other groups.
 Visible Groups - Each participant is a member of the group to which he has
been assigned but can see the work done by the other groups.
The group mode defined in the course settings is the default mode for course
activities. Group mode can be managed for each activity of the course as long as
the activity supports the groups and the group mode has not been forced to the
course level.

FORCE GROUP MODE
Forcing the group mode, this mode will be applied to all course activities. Any
different group arrangements will not be considered.

ROLE RENAMING
Allows customization of the names of the roles used in the course.
Privileges are not changed, only the name of the role will be changed. The
custom names of the roles will be used on the page with the list of course
participants and other pages of the course where the names of roles appear. If
you assign a custom name to a role that has been defined by the Site
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Administrator as Course Manager, the custom name will also appear in the course
description available within the categories.
To learn more about this topic, we recommend that you consult the official
documentation at the link: https://docs.moodle.org/35/en/Course_settings

3.3 MANAGEMENT OF THE COURSE SECTION
In the case of a course created with topics format, the material published by the
teachers can be divided into topics that are generally defined sections.

Operationally, therefore, a Section, which represents the "site" in which the
general course material that the teacher will make available to his students
can be uploaded or created, is composed of the following elements:
 Title;
 An introduction, a brief textual description of the content;
Pag. 23
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 The content consisting of the course material or that are called Activities
and Resources in Moodle.

3.3.1. Creating And Deleting A Section
Only after having selected the “TURN EDITING ON” button it is
possible to carry out operations on the Sections, including, obviously
the creation of new Sections and their elimination.
After selecting this button, a series of icons appears which allow you
to operate the Sections and their elements in various ways. In
particular at the bottom of the home page of the course two icons
appear, that allow you to add and remove sections.
The + icon allows you to create a new section at the bottom of the
list; however, the system allows you to move the section to another
position after creating it.
The - icon allow you to remove the last section at the bottom of the
list; this Section is not completely eliminated, but is only hidden
(selecting again displays + again, with its content).
To completely eliminated a section, it is therefore necessary to
completely eliminate the content and then select – (- icon).

3.3.2.

Change title and introduction of a section
To modify the title or the introduction of a Section, it is necessary to
select the “edit”
that appears at the end of the space reserved
for the introduction of the Section itself.
Selecting this icon allows you to view a specific modification form,
this form contains:
 Two fields for the management of the title, in particular a flag,
which allows to choose whether to use or not to use the

default title of the section (argument x, where x is a progressive
number, in the case of formats for topics) and a text field that
allows you to specify your own custom title.
Pag. 24
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 A text editor with which you can modify the introduction of the
Section.
To make the changes you have made final, you need to save your
changes by selecting the appropriate button at the bottom of the
page.

.

3.3.3 Content of a Section: Activity and Resources
Among the other operations that can be performed on a Section, all
the operations that allow the content to be managed are particularly
important, ie what has so far been generically referred to as course
material, intended as teaching material.
Before proceeding with the descriptions of these operations, however,
it is advisable to try to specify the type of “material” that can be
loaded, but also create within the Sections of one’s course.
By adopting the Moodle terminology, in each section of your course
you can add two types of elements: ACTIVITIES and RESOURCES.
In Moodle with the term Activity means a series of tools that are
made available to students, to interact with other students or
Pag. 25
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teachers, for example, forms, questions, chats, exercises, spaces in
which to upload files, etc…
The term Resources represents the actual contents of the course,
made available to students according to various formats. Among the
resources you can add to a Moodle section, you can mention files,
folders, links, to resource, hypertexts, web pages etc.

3.3.4 Section and conditional Activities/ Resources
It is possible to introduce sections, activities or resources, conditional:
on the basis of specific conditions that may concern the students
themselves, these contents can be shown or not to the students of
the course. This feature is generically defined as a conditional activity.
The conditions that can be introduced concern, for example:
 evaluations, entered through the platform itself, totaled by the
student during the quizzes, tasks or other proposed activities;
 Time limit of material availability.
 Restrictions on user profiles and their personal information.
These conditions are entered trough specific fields present at the end
of the entry form for each form of the Sections, Activities and
Resources.
It is possible to insert: more conditions of the same type, through
buttons that allow incrementally to add two fields of the same type
at a time; more conditions also of different types, creating complex
conditions

(for

example,

different

study

material

based

on

the

evaluations and available within a certain time window).

Pag. 26

Pag. 27

3 COURSE SETTING AND MANAGEMENT

Per approfondimenti consulta la pagina
https://docs.moodle.org/35/en/Restrict_access_settings
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3.4 SETTING RESOURCES AND ACTIVITIES
Add an activity or resource (at the bottom of the course section/ topic)

The specific operations for the addition of an Activity/Resource vary according to
the Activity/Resource itself and will be described later. However, there are some
descriptive fields to almost all Activities/Resources which it is already possible to
consider.
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GENERAL

This fields are:
Name
A text field that allows you to assign a name to the Activity/Resource,
name that will be displayed within the section in the course home page,
and that will act as a link to the Activity/Resource itself.

Description
A

text

editor

that

allows

you

to

enter

a

description

for

the

Activity/Resource you are creating.

View description in the course home page
A flag that allows you to view the description on the course home page,
just below the link of the Resource or Activity.
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GRADE (only for the activities)

Grading method
It is possible to choose the advanced evaluation method to be used for
calculating grades in a given context. To disable advanced evaluation and
use the default evaluation choose “simple direct grading”.

Grade category
Sets the category of the evaluator register in which the valuation of the
asset will appear.

Blind Marking
The blind evaluation hides the identity of the students from the evaluators,
the blind assessment setting will be blocked as soon as there is a delivery
or task evaluation.
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COMMON MODULE SETTINGS

Availability
Setting the availability on “Show on course page” the activity or resource
will be available to students (but subject to restrictions depending on any
access conditions).
Setting the availability on "Hide to students" the activity or resource will be
available only to the users with the privilege to visualize hidden activities
(by default, the users with the role of teacher or teacher not editor).

Id Number
Setting the ID number allows you to identify the activity for the evaluation
calculation. If the activity is not included in any calculation, the field can be
left blank.
The ID number can also be set in the Evaluation Register, but it will still be
editable only in the activity settings.

Group Mode (only for activities)
The settings has 3 options:
 Without Groups – Group mode is not active, each participant is part of
the same community.
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 Separate Groups – Each participant is a member of the group to which
he has been assigned and is not able to see the work done by the
members of the other groups.
 Visible Groups – Each participant is a member of the group to which he
has been assigned but can see the work done by the other groups.
The group mode defined in the course settings is the default mode for
course activities. Group mode can be managed for each activity of the
course as long as the activity supports the groups and the group mode has
not been forced to the course level.

Grouping (for activities only)
A grouping is a set of group of a course. Using groupings, members of
groups belonging to the same grouping will be able to share activities.
Available only for group members.
Selecting this option, the activity (or resource) will be available only for the
students of the groups belonging to the indicated grouping.

RESTRICT ACCESS

Date
Access criterion based on date and time. The availability dates determine
when a student can access the activity through the link on the course
home page.
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Evaluation to be obtained
The setting allows the definition of the score to be obtained before making
the activity available.
It is possible to add other conditions beyond the first one. The activity will
become available when all the conditions will be satisfied.

User profile field
It is possble to condition access according to the fields present in the user
profile.

Status of activity.
It is possible to define conditions for access to the activity based on the
completion status of the other activities. To use this setting the tracking of
task completion must be active. You can add more conditions than the first
one. The activity will become available with all the conditions will be met.

COMPLETION TRACKING.

The completion of the activities allows to keep track of the activities carried
out, both manually and automatically, upon the fulfillment of the set
conditions. It is possible to set multiple conditions, which must all be
satisfied for the activity to be considered completed.

Require view
The student must access the activity to complete it.
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Rating
The student’s activity will be completed when he has received an evaluation.
Setting a minimum grade, icons will be displayed for exceeding or not
exceeding.

Expected completion by
The settings defines the date in which the task is expected to be
completed. Students will not see the data, which will instead be displayed in
the completed activity report.
For further information:
https://docs.moodle.org/35/en/Activity_completetion_settings.
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4. ACTIVITIES
An activity is a general name for a group of features in a Moodle course.
Usually an activity is something that a student will do that interacts with other
students and or the teacher.
In Moodle terminology, an Activity, such as Forums or Quizzes, properly means
something students can contribute to directly, and is often contrasted to a
Resource such as a File or Page, which is presented by the teacher to them.
However, the term activity is sometimes for convenience also used to refer to
both Activities and Resources as a group.
There are 14 different types of activities in the standard Moodle that can be
found when the editing is turned on and the link 'Add an activity or resource'
is clicked.
ASSIGNMENTS
CHAT
CHOICE
DATABASE

Enable teachers to grade and give comments on uploaded
files and assignments created on and off line
Allows participants to have a real-time synchronous
discussion
A teacher asks a question and specifies a choice of multiple
responses
Enables participants to create, maintain and search a bank of
record entrie

FEEDBACK

For creating and conducting surveys to collect feedback.

FORUM

Allows participants to have asynchronous discussions

GLOSSARY

Enables participants to create and maintain a list of
definitions, like a dictionary

LESSON

For delivering content in flexible ways

(LTI) EXTERNAL
TOOL

QUIZ

Allows participants to interact with LTI compliant learning
resources and activities on other web sites. (These must first
be set up by an administrator on the site before being
available in individual courses.)
Allows the teacher to design and set quiz tests, which may
be automatically marked and feedback and/or to correct
answers shown

SCORM

Enables SCORM packages to be included as course content

SURVEY

For gathering data from students to help teachers learn
about their class and reflect on their own teaching

WIKI

A collection of web pages that anyone can add to or edit

WORKSHOP

Enables peer assessment
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4.1 ASSIGNAMENT
The assignment activity module enables a teacher to communicate tasks,
collect work and provide grades and feedback.
Students can submit any digital content (files), such as word-processed
documents, spreadsheets, images, or audio and video clips. Alternatively, or
in addition, the assignment may require students to type text directly into
the text editor. An assignment can also be used to remind students of 'realworld' assignments they need to complete offline, such as art work, and
thus not require any digital content. Students can submit work individually
or as a member of a group.
When reviewing assignments, teachers can leave feedback comments and
upload files, such as marked-up student submissions, documents with
comments or spoken audio feedback. Assignments can be graded using a
numerical or custom scale or an advanced grading method such as a
rubric. Final grades are recorded in the gradebook.
For further information consult

4.2

〉

More help https://docs.moodle.org/35/en/Assignment_activity

〉

Assignment settings

〉

Using Assignment

〉

Assignment FAQ

CHAT
The chat activity module enables participants to have text-based, realtime synchronous discussions.
The chat may be a one-time activity or it may be repeated at the same
time each day or each week. Chat sessions are saved and can be made
available for everyone to view or restricted to users with the capability
to view chat session logs.
Chats are especially useful when the group chatting is not able to meet
face-to-face, such as
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 Regular meetings of students participating in online courses to enable
them to share experiences with others in the same course but in a
different location
 A student temporarily unable to attend in person chatting with their
teacher to catch up with work
 Students out on work experience getting together to discuss their
experiences with each other and their teacher
 Younger children using chat at home in the evenings as a controlled
(monitored) introduction to the world of social networking
 A question and answer session with an invited speaker in a different
location
 Sessions to help students prepare for tests where the teacher, or
other students, would pose sample questions.
For further information consult
〉 More help https://docs.moodle.org/35/en/Chat_activity
〉 Chat settings
〉 Using Chat
〉 Chat FAQ

4.3

CHOICE
The choice activity module enables a teacher to ask a single question and
offer a selection of possible responses.
Choice results may be published after students have answered, after a
certain date, or not at all. Results may be published with student names or
anonymously.
A choice activity may be used
 As a quick poll to stimulate thinking about a topic
 To quickly test students' understanding
 To facilitate student decision-making, for example allowing students
to vote on a direction for the course
 For further information consult
For further information consult
〉 More help https://docs.moodle.org/35/en/Choice_activity
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〉 Choice settings
〉 Using Choice
〉 Choice FAQ

4.4

DATABASE
The database activity module enables participants to create, maintain and
search a collection of entries (i.e. records). The structure of the entries is
defined by the teacher as a number of fields. Field types include checkbox,
radio buttons, dropdown menu, text area, URL, picture and uploaded file.
The visual layout of information when listing, viewing or editing database
entries may be controlled by database templates. Database activities may
be shared between courses as presets and a teacher may also import and
export database entries.
If the database auto-linking filter is enabled, any entries in a database will
be automatically linked where the words or phrases appear within the
course.
A teacher can allow comments on entries. Entries can also be rated by
teachers or students (peer evaluation). Ratings can be aggregated to form
a final grade which is recorded in the gradebook.
Database activities have many uses, such as
 A collaborative collection of web links, books, book reviews, journal
references etc
 For displaying student-created photos, posters, websites or poems for
peer comment and review
For further information consult
〉 More help https://docs.moodle.org/35/en/Database_activity
〉

DataBase settings

〉

Building Database

〉

Database templates

〉

Using DataBase

〉

DataBase FAQ
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4.5

EXTERNAL TOOL
The external tool activity module enables students to interact with learning
resources and activities on other web sites. For example, an external tool
could provide access to a new activity type or learning materials from a
publisher.
To create an external tool activity, a tool provider which supports LTI
(Learning Tools Interoperability) is required. A teacher can create an
external tool activity or make use of a tool configured by the site
administrator.
External tool activities differ from URL resources in a few ways:
〉

〉
〉

External tools are context aware i.e. they have access to information
about the user who launched the tool, such as institution, course
and name
External tools support reading, updating, and deleting grades
associated with the activity instance
External tool configurations create a trust relationship between your
site and the tool provider, allowing secure communication between
them

For further information consult
〉 More help https://docs.moodle.org/35/en/External_tool

4.6

〉

External tool settings

〉

Using External tool

〉

External tool FAQ

FEEDBACK
The feedback activity module enables a teacher to create a custom survey
for collecting feedback from participants using a variety of question types
including multiple choice, yes/no or text input.
Feedback responses may be anonymous if desired, and results may be
shown to all participants or restricted to teachers only. Any feedback
activities on the site front page may also be completed by non-logged-in
users.
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Feedback activities may be used
〉
〉
〉
〉

For course evaluations, helping improve the content for later
participants
To enable participants to sign up for course modules, events etc.
For guest surveys of course choices, school policies etc.
For anti-bullying surveys in which students can report incidents
anonymously

For further information consult
〉 More help https://docs.moodle.org/35/en/Feedback_activity

4.7

〉

Feedback settings

〉

Building Feedback

〉

Using Feedback

〉

Feedback FAQ

FORUM
The forum activity module enables participants to have asynchronous
discussions i.e. discussions that take place over an extended period of
time.
There are several forum types to choose from, such as a standard forum
where anyone can start a new discussion at any time; a forum where each
student can post exactly one discussion; or a question and answer forum
where students must first post before being able to view other students'
posts. A teacher can allow files to be attached to forum posts. Attached
images are displayed in the forum post.
Participants can subscribe to a forum to receive notifications of new forum
posts. A teacher can set the subscription mode to optional, forced or auto,
or prevent subscription completely. If required, students can be blocked
from posting more than a given number of posts in a given time period;
this can prevent individuals from dominating discussions.
Forum posts can be rated by teachers or students (peer evaluation).
Ratings can be aggregated to form a final grade which is recorded in the
gradebook.
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Forums have many uses, such as
〉 A social space for students to get to know each other
〉 For course announcements (using a news forum with forced
subscription)
〉 For discussing course content or reading materials
〉 For continuing online an issue raised previously in a face-to-face
session
〉 For teacher-only discussions (using a hidden forum)
〉 A help centre where tutors and students can give advice
〉 A one-on-one support area for private student-teacher
communications (using a forum with separate groups and with one
student per group)
〉 For extension activities, for example ‘brain teasers’ for students to
ponder and suggest solutions to
For further information consult
〉 More help https://docs.moodle.org/35/en/Forum_activity

4.8

〉

Forum settings

〉

Using Forum

〉

Forum FAQ

GLOSSARY
The glossary activity module enables participants to create and maintain a
list of definitions, like a dictionary, or to collect and organise resources or
information.
A teacher can allow files to be attached to glossary entries. Attached
images are displayed in the entry. Entries can be searched or browsed
alphabetically or by category, date or author. Entries can be approved by
default or require approval by a teacher before they are viewable by
everyone.
If the glossary auto-linking filter is enabled, entries will be automatically
linked where the concept words and/or phrases appear within the course.
A teacher can allow comments on entries. Entries can also be rated by
teachers or students (peer evaluation). Ratings can be aggregated to form
a final grade which is recorded in the gradebook.
Glossaries have many uses, such as
〉 A collaborative bank of key terms
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〉
〉
〉
〉

A ‘getting to know you’ space where new students add their name
and personal details
A ‘handy tips’ resource of best practice in a practical subject
A sharing area of useful videos, images or sound files
A revision resource of facts to remember

For further information consult
〉 More help https://docs.moodle.org/35/en/Glossary_activity

4.9

〉

Glossary settings

〉

Using Glossary

〉

Glossary FAQ

LESSON
The lesson activity module enables a teacher to deliver content and/or
practice activities in interesting and flexible ways. A teacher can use the
lesson to create a linear set of content pages or instructional activities
that offer a variety of paths or options for the learner.
In either case, teachers can choose to increase engagement and ensure
understanding by including a variety of questions, such as multiple choice,
matching and short answer. Depending on the student's choice of answer
and how the teacher develops the lesson, students may progress to the
next page, be taken back to a previous page or redirected down a
different path entirely.
A lesson may be graded, with the grade recorded in the gradebook.
Lessons may be used
〉 For self-directed learning of a new topic
〉 For scenarios or simulations/decision-making exercises
〉 For differentiated revision, with different sets of revision questions
depending upon answers given to initial questions
For further information consult
〉 More help https://docs.moodle.org/35/en/Lesson_activity
〉

Lesson settings

〉

Building Lesson

〉

Using Lesson

〉

Lesson FAQ
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4.10 QUIZ
The quiz activity enables a teacher to create quizzes comprising questions
of various types, including multiple choice, matching, short-answer and
numerical.
The teacher can allow the quiz to be attempted multiple times, with the
questions shuffled or randomly selected from the question bank. A time limit
may be set.
Each attempt is marked automatically, with the exception of essay
questions, and the grade is recorded in the gradebook.
The teacher can choose when and if hints, feedback and correct answers
are shown to students.
Quizzes may be used
〉 As course exams
〉 As mini tests for reading assignments or at the end of a topic
〉 As exam practice using questions from past exams
〉 To deliver immediate feedback about performance
〉 For self-assessment
For further information consult
〉 More help https://docs.moodle.org/35/en/Quiz_activity
〉

Quiz quick guide

〉

Quiz settings

〉

Building Quiz

〉

Using Quiz

〉

Quiz reports

〉

Quiz FAQ

4.11 SCORM PACKAGE
A SCORM package is a collection of files which are packaged according to
an agreed standard for learning objects. The SCORM activity module
enables SCORM or AICC packages to be uploaded as a zip file and added
to a course.
Content is usually displayed over several pages, with navigation between
the pages. There are various options for displaying content in a pop-up
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window, with a table of contents, with navigation buttons etc. SCORM
activities generally include questions, with grades being recorded in the
gradebook.
SCORM activities may be used
〉

For presenting multimedia content and animations

〉

As an assessment tool

4.12 SURVEY
The

survey

activity

module

provides

a

number

of

verified

survey

instruments that have been found useful in assessing and stimulating
learning in online environments. A teacher can use these to gather data
from their students that will help them learn about their class and reflect
on their own teaching.
Note that these survey tools are pre-populated with questions. Teachers
who wish to create their own survey should use the feedback activity
module.
For further information consult
〉 More help https://docs.moodle.org/35/en/Survey_activity
〉

Survey settings

〉

Using Survey

〉

Survey FAQ

4.13 WIKI
The wiki activity module enables participants to add and edit a collection
of web pages. A wiki can be collaborative, with everyone being able to edit
it, or individual, where everyone has their own wiki which only they can
edit.
A history of previous versions of each page in the wiki is kept, listing the
edits made by each participant.
Wikis have many uses, such as
〉 For group lecture notes or study guides
〉 For members of a faculty to plan a scheme of work or meeting agenda
together
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For students to collaboratively author an online book, creating content
on a topic set by their tutor
For collaborative storytelling or poetry creation, where each participant
writes a line or verse
As a personal journal for examination notes or revision (using an
individual wiki)

〉
〉
〉

For further information consult
〉 More help https://docs.moodle.org/35/en/Wiki_activity
〉

Wiki settings

〉

Using Wiki

〉

Wiki FAQ

4.14 WORKSHOP
The workshop activity module enables the collection, review and peer
assessment of students' work.
Students can submit any digital content (files), such as word-processed
documents or spreadsheets and can also type text directly into a field
using the text editor.
Submissions are assessed using a multi-criteria assessment form defined by
the teacher. The process of peer assessment and understanding the
assessment form can be practised in advance with example submissions
provided by the teacher, together with a reference assessment. Students
are given the opportunity to assess one or more of their peers'
submissions. Submissions and reviewers may be anonymous if required.
Students obtain two grades in a workshop activity - a grade for their
submission and a grade for their assessment of their peers' submissions.
Both grades are recorded in the gradebook.
For further information consult
〉 More help https://docs.moodle.org/35/en/Workshop_activity
〉

Workshop quick guide

〉

Using Workshop

〉

Grading strategies

〉

Workshop FAQ
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5. RESOURCES
A resource is an item that a teacher can use to support learning, such as a file
or link. Moodle supports a range of resource types which teachers can add to
their courses. In edit mode, a teacher can add resources via the 'Add an activity
or resource' link. Resources appear as a single link with an icon in front of it that
represents the type of resource. The resources that the platform allows to
manage are the following:

BOOK

Multi-page resources with a book-like format. Teachers can
export their Books as IMS CP (admin must allow teacher role to
export IMS)

FILE

A picture, a pdf document, a spreadsheet, a sound file, a video
file

FOLDER

For helping organize files and one folder may contain other
folders

IMS
CONTENT PACKAGE

Add static material from other sources in the standard IMS
content package format

LABEL

Can be a few displayed words or an image used to separate
resources and activities in a topic section, or can be a lengthy
description or instructions

PAGE

The student sees a single, scrollable screen that a teacher
creates with the robust HTML editor

URL

You can send the student to any place they can reach on their
web browser, for example Wikipedia

5.1 BOOK
The book module enables a teacher to create a multi-page resource in a
book-like format, with chapters and subchapters. Books can contain media
files as well as text and are useful for displaying lengthy passages of
information which can be broken down into sections.
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A
〉
〉
〉

book may be used
To display reading material for individual modules of study
As a staff departmental handbook
As a showcase portfolio of student work
For further information consult
〉
More help https://docs.moodle.org/35/en/Book_module
〉

Book settings

〉

Using Book

〉

Book FAQ

5.2 FILE

The file module enables a teacher to provide a file as a course resource.
Where possible, the file will be displayed within the course interface;
otherwise students will be prompted to download it. The file may include
supporting files, for example an HTML page may have embedded images or
Flash objects.
Note that students need to have the appropriate software on their computers
in order to open the file.
A
〉
〉
〉

file may be used
To share presentations given in class
To include a mini website as a course resource
To provide draft files of certain software programs (eg Photoshop .psd) so
students can edit and submit them for assessment

For further information consult
〉 More help https://docs.moodle.org/35/en/File_resource
〉 File settings
〉 File resource FAQ

5.3 FOLDER
The folder module enables a teacher to display a number of related files
inside a single folder, reducing scrolling on the course page. A zipped folder
may be uploaded and unzipped for display, or an empty folder created and
files uploaded into it.
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A folder may be used

 For a series of files on one topic, for example a set of past examination
papers in pdf format or a collection of image files for use in student
projects.
 To provide a shared uploading space for teachers on the course page
(keeping the folder hidden so that only teachers can see it).
For further information consult
〉 More help https://docs.moodle.org/35/en/Folder_resource
〉

Folder resource settings

〉

Folder resource FAQ

5.4 IMS CONTENT PACKAGE
An IMS content package is a collection of files which are packaged according
to an agreed standard so they can be reused in different systems. The IMS
content package module enables such content packages to be uploaded as
a zip file and added to a course as a resource.
Content is usually displayed over several pages, with navigation between the
pages. There are various options for displaying content in a pop-up window,
with a navigation menu or buttons etc.
An IMS content package may be used for presenting multimedia content and
animations.
For further information consult
〉 More help https://docs.moodle.org/35/en/IMS_content_package
〉

IMS content package settings

〉

IMS content package FAQ

5.5 LABEL
The label module enables text and multimedia to be inserted into the course
page in between links to other resources and activities. Labels are very
versatile and can help to improve the appearance of a course if used
thoughtfully.
Labels may be used
〉 To split up a long list of activities with a subheading or an image
〉 To display an embedded sound file or video directly on the course page
〉 To add a short description to a course section
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For further information consult
〉 More help https://docs.moodle.org/35/en/Label
〉

Label module settings

〉

Using Label

〉

Label FAQ

5.6 PAGE
The page module enables a teacher to create a web page resource using
the text editor. A page can display text, images, sound, video, web links and
embedded code, such as Google maps.
Advantages of using the page module rather than the file module include the
resource being more accessible (for example to users of mobile devices) and
easier to update.
For large amounts of content, it's recommended that a book is used rather
than a page.
A page may be used
To present the terms and conditions of a course or a summary of the
course syllabus
To embed several videos or sound files together with some explanatory
text

〉
〉

For further information consult
〉 More help https://docs.moodle.org/35/en/Page_resource
〉

Page module settings

〉

Using Page

〉

Page FAQ

5.7 URL
The URL module enables a teacher to provide a web link as a course
resource. Anything that is freely available online, such as documents or
images, can be linked to; the URL doesn’t have to be the home page of a
website. The URL of a particular web page may be copied and pasted or a
teacher can use the file picker and choose a link from a repository such as
Flickr, YouTube or Wikimedia (depending upon which repositories are enabled
for the site).
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There are a number of display options for the URL, such as embedded or
opening in a new window and advanced options for passing information, such
as a student's name, to the URL if required.
Note that URLs can also be added to any other resource or activity type
through the text editor.
For further information consult
〉
More help https://docs.moodle.org/35/en/URL_resource
〉

URL resource settings

〉

URL resource FAQ
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6. EVALUATION
In this chapter some of the activities, available in Moodle, are grouped which
allow for the evaluation and verification of learning of the students. This tools are
typically interactive, as they require students to enter data, formulate answers, or
choose from proposed alternatives; for this reason they are classified as activities.
In reality, most of the activities in Moodle include the possibility of assigning
assessments; in this section we collect some of those that allow communication
between student and teacher. The activities described can be used at the
beginning of the course, inside or at the end, to verify the initial knowledge and
starting situations of the student, monitor the learning and offer the opportunity
to demonstrate that the didactic objectives have been achieved.

6.1 GRADER REPORT

Most of the moodle’s activities involve the assignment of an evaluation by the
teacher. The evaluation is enabled at the site level and in each course there is a
register with the evaluations of the students enrolled, whose settings are defined
by the administrator. In this register the votes obtained in the activities in which
the evaluation is planned and saved are saved. The settings defined by the
administrator are, for example, which roles are listed in the register, in which
format the votes can be exported, and in what form they must be saved.
The teacher can customize the appearance of the register of his course, how to
manage the evaluations of the activities and the grades to use. By clicking on the
Grades menu, the teacher accesses the register of evaluations, a table with the
names of the students and the evaluations, obtained. By clicking on the individual
tab, one can view the evaluation sheet of each user.
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For further information https://docs.moodle.org/35/en/Grades

6.2 EVALUATION CATEGORY
Activity evaluations can be entered under different categories. By clicking on
Categories And Elements in the evaluation management menu of the course
administration panel we can create new assessment categories, for example: first

and second term for a school course. Or exercises for final examination for a
university course, or a subdivision for topics and didactic modules. Each category
is given a name and a method for calculating the overall rating for the category:
in the item Aggregation of votes we will be able to decide whether to use the
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average of the votes that fall within that category, or the weighted average, or
the maximum, minimum, fad, the sum of the votes, possibly discarding the worst
votes.

Adding a grade category
To add a grade category:
 Select "Gradebook setup" from the gradebook dropdown menu.
 Click the "Add category" button near the bottom of the page.
 Give the grade category a meaningful name.
 Select grade category settings as appropriate. Advanced settings may be
made available by clicking the "Show more" link.
 Click the "Save changes" button.

For further information https://docs.moodle.org/35/en/Grade_categories
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6.3 SCORES AND SCALES
In every activity that involves an evaluation, it is necessary to establish which are
the votes that can be assigned. In general they can be scores, numbers between
0 and a maximum score set, or judgments included in a grading scale. To define
a new rating scale, click on Scale, also in the evaluation management menu on
the course administration panel, and click to Add a Scale button. Assign a name
to the scale, and under the heading Scale write the elements that compose it, for
example: Seriously insufficient, Insufficient, Sufficient, Good, Very good, Excellent.
Possibly an explanation and correspondence of the votes can be provided by
completing the Description field.
For further information:
Grade points: https://docs.moodle.org/35/en/Grade_points
Scale: https://docs.moodle.org/35/en/Scales

6.4 LESSON
The lesson is the most complete and flexible activity that allows both to insert
contents in the course and to interactively verify that they have been understood.
It is a real path made up of pages with texts and questions; at the end of each
page you can go to the next page or to another page of the lesson.
The peculiarity of the lesson is the flexibility: in fact is possible to personalize the
paths, the feedbacks and the evaluations furthermore, a lesson allows you to
transmit content during the evaluation, and it is a method that can be extremely
functional.
As with all other resources and activities, you must first save the general
settings, then move on to the actual construction of the lesson, page by page.
For now let’s just give a name to the lesson and save it, we’ll come back to the
various settings later; let us proceed instead with the construction of the lesson.
It is advisable to plan this activity so that you have clear ideas about what to do
with the lesson.
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When the lesson is accessed a panel similar to the one shown below is displayed

In the edit part, shown in the image, you can add pages to the lesson; there are
two types of pages: pages with content and pages with questions.

Add a content page
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This is a page where a teacher can provide information to move the lesson
forward but without requiring the student to answer specific questions.
 The student sees the page's title, some information and then one or more
buttons at the bottom to select.
 When the student clicks on a button, they go to the next page but their
choice is not scored.


Page title
The title of a content page appears to the student at the top of the
page.
 A teacher will also see the title in the collapsed edit mode when they
are working on the Lesson, and they will also be able to choose the
title (and hence this page) from the drop down "jump" lists.
 The title in a content page is also used with the "display left menu"
setting.


Page contents
This is where the teacher can add information for the student, making use of
the Text editor and its multimedia features.
Content:
Here the teacher writes the words they
want the student to click on to get to
the next part of the lesson.
These words will appear to the student
as a button.
The teacher can check the box to have
the buttons appear horizontally, or
uncheck it for them to appear centered
vertically.

The Jump
 Each Description in a Content page has a Jumps menu. "Jumps" take a
student from one page to another.
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 A "relative jump" is "next page" or "end of lesson" whereas an "absolute
jump" gives the actual name of a page.
 The teacher chooses from the dropdown the correct page to send the
student to if they click on the button that will be made from this
particular description. Any pages created by the teacher will have their
titles appear in this dropdown, allowing them to be selected.
 When a student clicks on a description button, they are sent to the
page defined in the Jump associated with the button.
Jumps are a unique feature of the Lesson module. Jumps are links and
determine what happens after a student makes a choice on a lesson page.
There are two basic types of jumps - Relative and Absolute.
For example, a teacher creates 10 Lesson pages and titles them P1 to P10.
P1, P2, P3, P4, P5, P6, P7, P8, P9, P10.
On P5, the teacher may want to send the student to P7 for one student
choice and to "Next Page" for other choices. In this example "P7" is an
absolute jump and "Next Page is a relative jump.

Absolute jumps
The absolute jump always goes to the same page that a teacher has
created. In our example we used P7.
P1, P2, P3, P4, P5, P6, P7, P8, P9, P10.
Note that the teacher can decide to change the title of "P7" to
"Grading" as the page title. The jump from P5 will automatically change.
P1, P2, P3, P4, P5, P6, Grading, P8, P9, P10.
Moving either page will not effect any absolute jumps. In the example
below the absolute jump in P5 will now skip 4 pages in the logical order.
P1, P2, P5, P3, P4, P6, P8, Grading, P9, P10.
Pages can have the same title and this can be confusing when setting
jumps. For example, it is a good practice to retitle an End of Branch
page so you don't end up with 5 pages all called End of Branch.

Pag. 57

EVALUATION

Pag. 58
Relative jumps

These kinds of jumps go to a position or create an effect. In our
example, a Next Page jump in P5 is the next page in the logical order of
the lesson is P6.
P1, P2, P3, P4, P5, P6, P7, P8, P9, P10.
The teacher may decide that more information is needed for those
students going to P6. The teacher can insert a page (called P5-b)
immediately after P5 and the Next Page jump will now go to P5-b.
P1, P2, P3, P4, P5, P5-b, P6, P7, P8, P9, P10.
Or the teacher can move another page to the position right after P5,
and the Next page jump will go there. In the example below P10 has
been moved and it has become the "Next page".
P1, P2, P3, P4, P5, P10, P5-b, P6, P7, P8, P9.
If the teacher moves P5 to another location in the logical order, the
relative jump will still look for the "Next page" in our example this will
now be P10.
P1, P2, P3, P4, P6, P7, P8, P9, P5, P10.
Here are a few of the relative jumps that a teacher might find in a
Lesson page.
The random relative jumps need to be planned with care. The were
designed to be used within a segment of a lesson.

Next page
We have covered this relative jump in our above example. It is also the
default jump for the first answer of any question or content (branch
table) page choices.

This page
This page takes the student back to the page they just viewed. Lesson
will usually use this jump as a default in most question and content
pages, if it didn't use "Next page".
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Previous page

The page which is in front of the current page in the logical order.

End of lesson
The end of lesson is the splash screen a student sees when they have
completed the lesson. In the simple lesson, this follows the last page in
the logical order. It may show their score, offer a link to the next lesson
or just say that they have completed the lesson. This jump is often used
as a content page choice to allow the student to end the lesson at that
point in the Lesson.

Unseen question within a content page
This will link to a randomly chosen unseen (by the student in this
attempt) question between this content page and the End of the Lesson
or the next End of Branch. This might be used in a segment of a lesson,
where it is used in as a jump in C2 in the example below. Use with care.
C1, C2, Q1, Q2, Q3, EoB, C3, C4, C5, Q4, C6.

Random question within a content page
This will link to a randomly chosen question between the current content
page and the End of Lesson or the next End of Branch. If the student
has already seen the question and attempts are greater than 1, they will
get another chance to earn the point(s) for that question. If attempts are
set to 1, the question will be skipped and another random question
shown. Use with care.
C1, C2, Q1, Q2, Q3, EoB, C3, C4,C5, Q4,C6.

Random content page
This will jump to a random Content page between the current Content
page and the End of Lesson or the next End of Branch. It is used in a
segment and is a jump in C2 shown below. Use with care.
C1, C2, C3, C4, C5 EoB, Q1, Q2, Q3, Q4, C6.
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Add a question page

(Note: These question types are not the same as the Quiz Question types and are in no way
connected with quiz questions.)

A page with a question, as can be expected, contains a question that,
depending on the answer given, will allow you to move to another page of the
lesson.
The format of question pages is similar to content.
A typical question page could include:
Title - the name the student sees at the top of the question page.
Page contents - the actual question
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Answer/Response/Jump/Score as in the screenshot below

Question types
Multichoice
The student is given a question and a list of answers. The answer list will
be shuffled every time the question is view by a student. By default they
choose one answer but you can check the box "multiple answer" to allow
them to choose more than one answer.
The file picker is available in the editor so that images and other media
may be uploaded as part of the answers and responses.

Essay
Students

can

write

a

longer

answer

that

will

be

evaluated

later by the teacher. Therefore the score is not assigned; it must be
only one jump action is scheduled for another page, which will be executed
whatever the answer is given.

Matching
This allows you to set up lists which must be matched against other lists,
for instance, words, pictures, numbers etc. The student must match all
correctly to receive the score.
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Numerical

This requires a number as an answer. A number within a range may also be
accepted as correct. The range separator to be used is the colon: For
example, to accept as correct any number between 10 and 12 (10, 11 and
12) you would type 10:12 in the answer box. Only the plain text editor is
available in the answer box.

Short answer
A student must provide a single word or short phrase answer. The teacher
must anticipate the possible answers and enter them in the answer box,
using ** wild cards if appropriate. Only the plain text editor is available in
the answer box.
You can include 5 or more underscores in the question text and these will
be replaced for the student by the answer box. (This also means that fill in
the blank questions may be imported from Blackboard and other LMS.)
Including

more

underscores

will

make

the

answer

box

wider.

True/false
The student is given a sentence and must decide if it is true or false

Add a cluster
A cluster is a group of question pages which will be offered randomly to a
student as they work through the lesson. It is best if you have made the question
pages beforehand and can then decide where to mark the start and end of the
cluster. The start is marked by a "cluster" page and the end by an "end of
cluster" page.
For further information https://docs.moodle.org/35/en/Lesson_clusters

Lesson settings
Now let's go back to the lesson settings: now that we understand how it works
we can choose the options that best suit the result we want to achieve.
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To return to the general settings, simply enter the lesson and click on Settings in
the lesson administration menu.

Appearance

the lesson page can be customized and flexibly managed. The lesson can begin
with a pop-up window that opens to display a file. This must be loaded into the
appropriate Pop-up file space. It is also possible to view the score obtained during
the course, updated with each question and indicated with respect to the total
score obtainable up to that point. Viewing the current score is a great way to
motivate students to complete the lesson. Including a progress bar and the menu
on the left will make it easier to follow the thread of the lesson and understand
where it has arrived. You can optionally choose a minimum rating from which to
view the lesson menu. By enabling the Slideshow field the lesson will be displayed
in the form of slides, pages of fixed height and width. You can then still choose a
maximum number of answers to the multiple choice questions, a default feedback
(when a question has not been established in Progress bar specific feedback is
given the right answer or wrong answer) and finally the link with an activity, that
is, another course activity to be displayed when the lesson is over.

Progress bar
Choose this to show a bar at the bottom of the page showing how far into
the lesson the student has got.
For lessons containing only Content pages, once a lesson has been taken
to the end, if that same lesson is re-taken, the progress bar will not be
"reset", i.e. it will show a 100% progress from page 1!
For lessons containing Question pages and set to "Re-take" Yes, the
progress bar is always "reset" at 0% upon re-take.
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Note that the Lesson Progress bar only works correctly for lessons with a
"straightforward" navigation, such as page 1 -> page 2 -> page n -> end of
lesson. It is not guaranteed to work with pages "jumping all over the place".

Display menu
Choose this when you want to show a list of the content page titles in the
Lesson to the student. Only those pages which have "Display in menu?"
checked will display. The menu will not display question pages

Show more
Depending on the what the administrator has specified as 'Advanced', other
settings will be displayed by clicking a 'Show more' link:

Linked media
If you want to include a link to a media file for students to refer to, upload
it here. A 'Click here to view' link will be displayed in a block called 'Linked
media' on each page of the lesson.
The width and height of the pop-up window may be set by an admin in Site

administration > Plugins > Activity modules > Lesson.

Display ongoing score
Choose this to let students see their score as they work through the lesson.

Minimum grade to display menu
Choose this if you want the student to go through the lesson once and get
a grade before they can (on review) see and navigate through all the
different pages.

Slideshow
Slideshow height, width and background colour are set for the whole site by
an administrator in Site administration > Plugins > Activity modules >
Lesson.

Maximum Number of Answers
Here you can set the default number of selection boxes available when you
add or edit a question or content page. For instance, if you are only going
to use Multiple Choice questions with 3 answers in your lesson, you might
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select 3. You can change the default here at any time to display more or
less question answers or content choices.

Use default feedback
Every Moodle site has a standard response (feedback) when a student
selects a correct or wrong answer in a lesson. Select "No" if you only what
you put as a response for a specific question's answer to display. In this
case, when you leave the response to a question blank, the student will not
see

any

comment

about

their

answer.

The

typical

Moodle

standard

responses are: "That's the correct answer" or "That's the wrong answer".

Link to next activity
Choose this to give students a link to another activity when they reach the
end of the lesson.

Availability

Available from/Deadline
Here you can set a start and end date and time for your Lesson.

Time limit
This allows you to set a time limit on the lesson which can now be
seconds, minutes, hours, days or weeks. Students will see a countdown
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counter in a block as they work. (Note that this does not work if the lesson
is downloaded for offline use via the mobile app.)

The timer does not stop them doing the lesson when the time is up, but
correct answers are no longer scored.

Password protected lesson
Change to "Yes" and enter the password if you want students only to
access it when they know the password.

Allow lesson to be attempted offline
Enabling this setting means the lesson can be downloaded and done offline
by a mobile app user. Lessons which are timed may not be attempted offline

Flow control

these options refer to the possibility of navigating within the lesson.
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Allow Student Review
choosing yes the user can move freely back and forth during the lesson.
Normally this parameter is set to no, ie the student is bound to follow the
course set for the lesson.

Provide option to try a question again
when the answer is wrong a button will appear that allows the student to
try the answer again or continue the lesson.

Maximum Number of Attempts
is the maximum number of attempts granted for each response. When it is
reached you will have to continue with the lesson.

Action after a Correct Answer
you can choose what happens between following the normal flow of the
lesson (normal), viewing a page that has not been viewed (you are directed
to another random page, among those not yet displayed), or view a page

where it is not an answer was given, always chosen randomly. Attention:
choosing the second or the third option deactivates the normal flow of the
lesson, and the pages are shown in random order. In this case you can
also choose a number of pages to display.

Grade
Here are all the evaluation settings. The final grade can be a score or be
chosen on one of the scales de ﬁ ned in the section of the course
dedicated to evaluations. If you set up the lesson as a trial lesson, the final
evaluation will not appear in the assessment log. Select yes under the
heading Custom score, if you want to assign a score to each answer. You
can give the possibility to retry an answer and, in this case, determine
whether for repetitions consider the average or the best rating.

Practice lesson
Practice lessons are now saved; this means they will appear in the reports
.You must enable the "Retakes allowed" setting if you want students to be
able to attempt a practice lesson several times.
Note: If you are upgrading from an earlier version, be aware that all
practice lessons will have " Re-takes allowed" set to "Yes" . If you are
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restoring a practice lesson made before this change, you may need to
modify the "Re-takes allowed" setting if needed.

Custom Scoring
Use this to give a particular number score (negative or positive) to each
answer

Re-takes allowed
Choose this if you want your students to be able to do the lesson more
than once.
Note that this setting only applies to lessons containing Question pages.
Lessons consisting only of Content pages can be re-taken even if 'Re-takes
allowed' is set to No.

Handling of re-takes
If you allow your students to re-take the lesson, then decide here if the
grade for all lesson attempts is the mean or the maximum.
Note that the Question Analysis always uses the answers from the first tries
of the lesson. Re-takes by students are ignored.

Minimum Number of Questions
Set the minimum number of questions that will be used to calculate a
student's score. Students will be told how many they have answered and
how many more they need to answer.
If you are using Content pages, then set this to 0.
If you use this setting, then add some explanatory text at the start of the
lesson so the student knows the minimum number of questions they must
answer to receive a grade.
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6.5 QUIZ
Of all activities, one of the most suitable for the construction of verification tests
is the quiz module.
The quiz activity module allows the teacher to create questionnaires with different
types of questions: multiple choice, true/ false, correspondence, short answer,
calculated, etc…
The teacher can set the quiz so that it can be attempted several times with the
order of questions changed randomly or with questions randomly extracted with
each new attempt. It is also possible to set a maximum unwinding time.
Each attempt i automatically evaluated (except for the composition questions) and
the evaluations is stored in the evaluator’s register. The teacher can decide when
and how to show to the students the correct answers, the feedback and any
suggestions.
You can use the quiz for:
•

Course exams,

•

test your self on study notes or at the end of a topic,

•

practice exams using questions from previous year’s exams,

•

give a performance feedback,

•

self evaluation.

As for other activities, to build a quiz first you need to define the general settings
and then enter the questions within it.
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Timing

Open/Close
Students can try the quiz only after the opening date. They must also end
the attempt by the closing date.
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Time limit
The setting allows the visualization of the time limit in the quiz start page
and a timer in the quiz navigation block that presents the countdown of the
remaining time.

Time is up
The setting controls what happens when the student does not send his
attempt before the time runs out. In this case the students are still working
on the quiz, the timer will send the attempt, however if the students were
no longer online for some reason, the setting allows to decide the action
from.

Extra time for sending
The time allowed for the student to send the attempt after the maximum
time has expired. To used in combination with the setting allows the student
to send the attempt within a set time limit, without allowing him to answer
other questions.

Grade

Grade category
If you have categories in your gradebook, select the one you wish the quiz
to be in here.

Attempts allowed
Students may be allowed to have multiple attempts at a quiz. This can help
make the process of taking the quiz more of an educational activity rather
than simply an assessment.
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Grade to pass
Represents the minimum grade necessary to consider the activity as
exceeded. This vote will be used to complete the activities and courses. In
the register of the assessor the mark will be in red (not passed) or green
(passed).

Grading method
When multiple attempts are allowed, there are different ways you can use the
grades to calculate the student's final grade for the quiz.:
 The highest grade - the final grade is the highest (best) grade in any
attempt
 Average grade - the final grade is the average (simple mean) grade of all
attempts
 First grade - the final grade is the grade earned on the first attempt (other
attempts are ignored)
 Last grade - the final grade is the grade earned on the most recent
attempt only.

Layout

New page
For longer quizzes it makes sense to stretch the quiz over several pages by
limiting the number of questions per page. When adding questions to the
quiz, page breaks will automatically be inserted according to the setting you
choose here. However, you will also be able to move page breaks around
by hand later on the editing page.

Pag. 72

Pag. 73

EVALUATION

Note that changing this setting has no effect on questions you have already
added to the quiz. The setting will only apply to questions you add
subsequently. To change the page breaks in an existing quiz, you need to
go to the quiz editing screen, tick the 'Show page breaks' checkbox, then
use the repaginate control.

Navigation method (available by clicking Show More)
Choose Sequential instead of Free, if you want to force the student to
progress through the questions in order and not go back to a previous
question or skip to a later one.

Question behaviour

Shuffle within questions
By enabling the setting, the sequence of possible alternative answers will be
changed randomly at each attempt by the student. The setting will only
work if the same setting will also be enabled in the question settings.

How questions behave

Deferred feedback
Students must enter an answer to each question and then submit the entire
quiz, before anything is graded or they get any feedback.

Adaptive mode and Adaptive mode (no penalties)
Allows students to have multiple attempts at the question before moving on
to the next question. This behaviour requires that the "Whether correct" box
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is ticked under "During the attempt" in the "Review options" section, at a
minimum.

Manual grading
Used for essay questions (irrespective of what the quiz is set to) but
you can now choose to have every question in the quiz manually
graded, if you wish.

Interactive with multiple tries
After submitting one answer, and reading the feedback, the student
has to click a 'Try again' button before they can try a new response.
They can be given hints to help them. Once the student has got the
question right, they can no longer change their response. Once the
student has got the question wrong too many times, they are just
graded wrong (or partially correct) and get shown the feedback and
can no longer change their answer. There can be different feedback
after each try the student makes. The number of tries the student
gets is the number of hints in the question definition plus one.

Immediate feedback
Similar to interactive mode in that the student can submit their
response immediately during the quiz attempt, and get it graded.
However, they can only submit one response, they cannot change it
later.

Deferred feedback or Immediate feedback with Certaintybased marking (CBM)
With CBM, the student does not only answer the question, but they
also indicate how sure they are they got the question right. The
grading is adjusted by the choice of certainty, so that students have
to reflect honestly on their own level of knowledge in order to get
the best mark.

Conditional questions
If using the Interactive with multiple tries or Immediate Feedback
behaviour and with the navigation method set to 'Free', it is possible
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to make the display of a question dependent on a previous question
being answered first.
The question editing page will display padlock icons to the right of
each question

Review options
This section controls what information students will be shown when they review
their past attempts at the quiz, and during the attempt in adaptive mode. It is a
matrix with check boxes.

The various pieces of information that can be controlled are:
 The attempt
Will show how the student responded to each question.
 Whether correct
Displays whether the students response to each question is correct or
incorrect.
 Marks
Reveals the marks awarded to the student and the grade for the quiz.
 Specific feedback
Will show the feedback for the response to the answer as set when adding
the question to the quiz. Each response to a question can have feedback
for both correct and incorrect answers.
 General feedback
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Displays the general feedback for the whole question as set when adding
the question to the quiz. You can use the general feedback to give
students some background to what knowledge the question was testing.
 Right answer
Reveals the correct answer to each question, whether the student answered
correctly or not (See note below).
 Overall feedback
Displays feedback for the entire quiz as set in the quiz settings (See note
below).
For each of the above items, you can determine the timeframe when the students
will see them:
 During the attempt
is only available when ‘How questions behave’ has been set to ‘Immediate

feedback’, ‘Immediate feedback with CBM’ and ‘Interactive with multiple tries’.
If set to one of these options then a ‘Check’ button will appear below the
answer and when clicked the student will submit that response and then
receive immediate feedback.
 Immediately after the attempt
means within 2 minutes of the student clicking "submit all and finish".
 Later, while the quiz is still open
means after 2 minutes, but before the close date (if the quiz does not have
a close date, this phase never ends).
 After the quiz is closed
means what it says (you never get here for quizzes without a close date).

Tip: Checking any of the boxes in the timeframe row, will reveal the test to
the student. For example, to allow students to see their quiz immediately
after taking it but not later, make sure none of the boxes in "Later" or
"After" rows are checked. The student will be able to see their grade but
not get into the quiz.
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Appearance

Show the user's picture
It is now possible, when displaying the user's profile picture for proctoring
purposes, to choose whether a large image or thumbnail will be displayed.

Decimal places in grades
This option determines how many digits will be shown after the decimal
separator when the grade is displayed. A setting of 0 for example means
that the grades are displayed as integers. This setting is only used for the
display of grades, not for the display or marking of answers.
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Extra restrictions on attempts

Require password
If you specify a password in here then participants must enter the same
password before they are allowed to make an attempt on the quiz. This is
useful to give only a selected group of students access to the quiz. If you
have many users taking one simultaneous quiz, it may help to assign a very
long password to the quiz, so that the load on the server is spread over
time.

Require network address
You can restrict access for a quiz to particular subnets on the LAN or
Internet by specifying a comma-separated list of partial or full IP address
numbers. This is especially useful for a proctored (invigilated) quiz, where
you want to be sure that only people in a certain room are able to access
the quiz. For example: 192.168. , 231.54.211.0/20, 231.3.56.211
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There are three types of numbers you can use (you can not use text based
domain names like example.com):
1. Full IP addresses, such as 192.168.10.1 which will match a single
computer (or proxy).
2. Partial addresses, such as 192.168 which will match anything starting
with those numbers.
3. CIDR notation, such as 231.54.211.0/20 which allows you to specify more
detailed subnets.
Spaces are ignored.

Enforced delay between attempts
You can set a time (from seconds to weeks) between the first and second
attempt of a quiz. You can also (or alternatively) set a time from seconds
to weeks for subsequent attempts after the second attempt. Thus, you might
allow a student to take the quiz twice immediately with no delay, but if
they want to improve their score with a third attempt, they are forced to
wait a week and use the time for extra revision.

Browser security
This is by default an advanced field, visible by clicking "Show advanced".
The options in this section offer various ways to try to restrict how students
may try to 'cheat' while attempting a quiz. However, this is not a simple
issue, and what in one situation is considered 'cheating' may, in another
situation, just be effective use of information technology. (For example, the
ability to quickly find answers using a search engine.)
Note also that this is not just at problem of technology with a technical
solution. Cheating has been going on since long before computers, and
while computers make certain actions, like copy and paste, easier, they also
make it easier for teachers to detect cheating - for example using the quiz
reports. The options provided here are not fool-proof, and while they do
make some forms of cheating harder for students, they also make it more
inconvenient for students to attempt the quizzes, and they are not foolproof.
Full screen pop-up with some JavaScript security
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There is a limit to what the quiz, which runs on a web server, can do to
restrict what the student sitting at their computer can do while attempting the
quiz. However, this option does what is possible:
 The quiz will only start if the student has a JavaScript-enabled webbrowser.
 The quiz appears in a fullscreen popup window that covers all the other
windows

and

has

no

course

navigation

controls.

(However,

it

is

impossible for a web site to create a browser window that cannot be
minimised or moved aside.)
 The students are prevented, as far as is possible, from using facilities
like copy and paste.

Overall feedback

Overall feedback is shown to a student after they have completed an attempt at
the quiz. The text that is shown can depend on the grade the student got. Click
"Show editing tools" to display the rich text editor, and drag the bottom right of
the text box out to expand it.
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Like the other activities, to build a quiz first you need to define the general
settings and then enter the questions within it.
As the questions are created, they are saved in a personal question archive,
from which you can draw on to build more quizzes in the future.
The difficulty in preparing the quiz lies in the construction of the individual
questions, which is complex and laborious; it is not wasted effort anyway, the
questions can in fact be easily modified and reused in other quizzes.

For further information
〉 Quiz quick guide https://docs.moodle.org/35/en/Quiz_quick_guide
〉

Building Quiz

〉

Using Quiz

〉

Quiz reports

〉

Outcomes

Pag. 81

Pag. 82

MANAGING QUESTIONS

7. MANAGING QUESTIONS
Questions are stored in the course Question bank in Administration > Course

administration > Question Bank

Questions can be organized into question categories and shared with other
teachers
Moodle has a number of different formats that can be used to import or export
questions

7.1 QUESTION CATEGORIES
A question category can contain individual questions or other question categories.
They can be found by using the Question bank or when building a quiz.
Each category must have a name and you can include a short description of the
category. You can create a category hierarchy. For example, you can specify a
parent category for each category or the 'Top' as the parent, when a category
has no parent.
Tip: Creating question categories and sub categories is a good practice. It is better
than keeping all your questions in one big list in the quiz module. The hierarchy
feature enables you to separate categories into sub categories and sub categories
into sub sub categories etc. indefinitely. Categories and sub categories, etc., are
very powerful when combined with random questions that can select either from
one category or from a category or any of its sub categories.

Question Sharing
You can share questions in several different contexts. Sharing categories in the
'System' context or 'Course' context has a similar effect to publishing the category
so others can see them or hiding a question category from specific users. See
the Question contexts page for more information.
By default a course teacher cannot see or use any Question context above the
course level.
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Note: "Core System" and "System" refer to the same thing when we are describing
or showing screen shots of question categories. "System" is the current term you
will see in 2.x releases of Moodle.

Category Set Up and Management
〉

〉
〉
〉

〉

Open the question bank. Either :
o Click on the Questions link in the 'Administration' block click on
the 'Questions' link.
o Or open the Editing a quiz page - when logged in as a teacher or
someone with appropriate permissions open a quiz and then click
on the 'Edit' tab.
Click on the 'Categories' tab.
Below the list of current categories you will see a form to add a new
category.
Choose the 'parent' category in which your new category will be placed.
See image of 'Parent' selector image.

Placing your category in another category makes it a sub-category of the
parent.
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Choosing 'Top' means that your category is a top level category, not a sub
category. When more than one sharing context is available you can place
your category as a top level category in any of the contexts.

〉

Notice you can choose to make your category a 'top level' category in any
context (see Question contexts) that is available to you. Or you can choose
to add your category as a sub category of another category in the same
context as the

〉

Type the name of your new question category in the text box.

〉

Add an optional meaningful description in the category info area.

〉

Click the 'Add Category' button. Your new question category will appear in
the list of current categories.

Deleting Categories
Categories can also be created or deleted at will. However, if you try to delete a
category containing questions, then you will be asked to specify another category
to move them to. You cannot delete or move the last category in any context,
there must always be one category in a context.

Moving categories
You can also arrange the categories in a hierarchy so that they are easier to
manage.

Reassign top category to move categories
Use the question bank>categories link to change the parent category. This will
change the order.

Using arrow icons to move categories
The up/down arrow icons lets you change the order in which category 'peers' are
displayed.
The up / down icons are also used to move a top-level category between
contexts. If you move a category to be the first or last category in a context and
then press the arrow key again then it will be moved to the next context.
The right arrow icon allows you to move a category to be a child category of the
category listed immediately above it.
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The left arrow icon allows you to move a category up one category level (to be
a peer of it's parent category).

See the tool tip that appears when you place the mouse pointer above these
icons if you're not sure what action an icon will perform. You cannot move the
last category in any context, there must always be at least one category left in
all contexts.

7.2 QUESTION BANK
This feature allows a teacher to create, preview, and edit questions in a database
of question categories. The categories can be limited to being used on the site,
course or quiz level. The questions in a category can be added to a Quiz or to a
lesson activity via an export process. The teacher enters the question bank by
creating or editing a quiz activity or via Course administration > Question bank

Select a category
Questions are organised into categories. Initially each course has only one
category called "Default". It is good practice to create more categories to
organize your questions. This not only makes it easier to find questions, but
makes the use of random questions and matching question easier. You can create
a hierarchy of categories because you can create subcategories inside parent
categories. To add or edit categories click on the "Categories" tab.
The question editing screen shows the questions from the currently selected
category. You choose this category from the Category: drop-down menu. Using
the tick box below that menu you determine whether to also show the questions
from all subcategories.

Categories are shared in contexts
There are separate question category trees in each different 'context' in which
questions are shared. The contexts available to you depend on whether you
access the question bank from an activity or from a course and depend on the
permissions assigned you for access to questions. See Question contexts for more
information on these contexts.
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Add a new question

1. Click the Questions tab to access the Question Bank page, if not there
already.
2. From the Category drop-down menu, select a category you want to add a
question to.
3. The page will change to show the questions already in that category
4. Select the question type you want to create from the Create new question
drop-down menu.
5. Fill in the form for the question type you are creating. Each question type
has its own form and has its own options.
6. Click Save Changes at the bottom of the form.

Edit, duplicate, preview, delete and move
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Each question in the question bank has four icons which allow you to edit,
quickly duplicate, preview and delete the question. (The question may not be
deleted if it is already in use elsewhere.) To duplicate a question, click the
duplicate icon (second from the left) and a copy of the question editing screen
will appear. You can either edit this new copy or simply scroll down and click
"Save changes."To move a question into a different category or subcategory, click
into the box on its left; scroll down to "With Selected..." and choose "Move to.."

Tips and tricks
 Put the answer into the question name so you can quickly see the answers
when students are asking for answers. This is especially useful if you're
dealing with large sets of questions! (No option yet for viewing category or
answer of question in the list of questions.)
 Export questions in GIFT or Moodle XML formats, then import them into a
Lesson. (Future versions of Moodle will make Question bank available to
both Lesson and Quiz activities.)
 Remember that while some of the same question types can be found in
both the Quiz and Lesson modules, they can be very different. Scoring and
grading each student's choice is more robust in a Quiz. On the other hand,
each Lesson question answer also has a jump associated it.
 Use GIFT or other export modes to print questions and answers in a
category. Hint, clever use of word processor macros, using search and
replace, can tidy up a GIFT file for printing.
 The question title is useful in sorting and making notes. For example, "ZZ
remove 2010-3 Why did the Moodler cross", will put this question at the
bottom of the list. Or where you want a 'the' questions in a category to
appear in a specific order, use letters or numbers, knowing that AA will
come first, AB will be second in the list.
 Do a copy and paste from a PDF file into the question content area.
Reduces "other" hidden code which Word, Open Office and other programs
can insert.

Sharing and Managing Question banks
Be default, teachers can manage only the questions in the context of the courses
they are in. You can set up a role to allow teachers to share and manager
questions on a larger scale.
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You can also use this role to create a special system-wide "Question bank
Manager" instead of giving admin level or site-wide Manager access to a person
managing the Questions.

7.3 QUESTIONS
Questions can be created in Moodle for use in quizzes and for import into
lessons.

Question types
〉

Calculated

〉

Simple Calculated

〉

Drag and drop into text

〉

Drag and drop markers

〉

Drag and drop onto image

〉

Calculated Multichoice

〉

Description

〉

Essay

〉

Matching

〉

Multiple Choice

〉

Random Short Answer Matching

〉

Select missing words

〉

Short-Answer

〉

Numerical

〉

True/False

〉

Third-party question types

Multiple Choice question type
Moodle provides teachers with a lot of flexibility when creating this common
question type. You can create single-answer and multiple-answer questions,
include pictures, sound or other media in the question and/or answer
options (by inserting HTML) and weight individual answers. Remember that
Lesson module questions behave differently.
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There are two types of multiple choice questions - single answer and
multiple answer.

Single-answer questions
These questions allow one and only one answer to be chosen by providing
radio buttons next to the answers. You can specify negative or non-negative
marks for each answer, usually zero marks for wrong answers, maximum
marks for correct answers and partial marks for partially correct answers.

Multiple-answer questions
The teacher can select "multiple answers are allowed" in a Multiple Choice
question type. "Multiple answers" questions types in a quiz allow one or
more answers to be chosen by providing check boxes next to the answers.
Each answer may carry a positive or negative grade, so that choosing ALL
the options will not necessarily result in good grade. If the total grade is
negative then the total grade for this question will be zero.
Feedback can be associated either with specific answers, or with the
question as a whole.

Question set-up
1. Select the question category
2. Give the question a descriptive name. You'll use the name to track your
questions later so "Question 1" isn't a good idea. The name will be used
in the question lists on the quiz editing page or in the lesson as a page
title. It will not be shown to the students, so you can choose any name
that makes sense to you and possibly other teachers.
3. Create the question text. If you're using the HTML Editor, you can format
the question just like a word processing document.
4. Select an image to display if you want to add a picture to the question.
The available images are those you have uploaded to the main Moodle
files area (they cannot be in folders). For the student, the image appears
immediately after the question text and before the answer options.
5. Alternatively, if you used the HTML editor to create the question text,
you can click the image icon. This will pop up the Insert Image window.
You can choose to upload an image into your files area from this
window, or you can add the URL of an image on the web. If you add a
file to your files area, click the name of the file after you upload it to
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insert the link into the URL text entry at the top of the screen. Then
click OK.
6. Set the 'default question grade' (i.e. the maximum number of marks for
this question).
7. Set the 'Penalty factor' (see Penalty factor below).
8. If you wish, add general feedback. This is text that appears to the
student after he/she has answered the question.
9. Choose whether students can only select one answer or multiple answers
10. Choose whether to shuffle the answer options
11. Write your first answer in the Choice 1 text field. Inserting HTML into this
area also makes it possible to add an image or a sound file.
12. Select a grade percentage for the answer. This is the percentage of the
total points for the question that selecting this response is worth. You
can select negative percentages as well as positive percentages. So,
selecting a correct response in a multiple answer question may give you
50% of the possible points, while selecting a wrong answer may take
away 10%. Note that in a multiple-answer question, the grades must add
up to 100%.
13. Be aware that if you allow multiple answers and have more than a
single correct choice, and do not use a negative grade percentage for
wrong answers, the students can simply tick all choices and get the full
grade.
14. If you wish, you can add feedback for each response. It may be a bit
more work, but it’s good practice to tell the students why each answer
is right or wrong using the feedback area. If students know why an
answer is right or wrong, they can analyse their own thinking and begin
to understand why an answer is correct. Your feedback will only be
displayed if you select Show Feedback in the quiz body options.
15. Fill in the rest of the response choices in the rest of the form. Any
unused areas will be ignored.
16. Fill in the overall feedback fields if you wish.
17. Select the "Save Changes" button at the bottom of the screen.

Lesson module multiple choice questions
This page was created for the Quiz module. A Lesson Multiple Choice or
Multianswer question type looks the same to the student but is very
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different in the teacher's edit mode. A lesson question offers the teacher
the chance to both grade a student's answer, give feedback and also to
send the student to another specific page based upon the student's choice.
There are other differences. Quiz has a more robust scoring system that is
similar to "Custom Scoring" in the Lesson module. Even with custom scoring
turned on, Lesson will not give percentage credit of a question's score for
an answer. And students must select all the correct answers to receive any
credit for the multianswer question in the Lesson module.
See https://docs.moodle.org/35/en/Multiple_Choice_question_type

True/False question type
A student is given only two choices for an answer in this kind of question:
True or False. The question content can include an image or html code.
When feedback is enabled, the appropriate feedback message is shown to
the student after the answer. For example, if the correct answer is "False",
but they answer "True" (getting it wrong) then the "True" feedback is shown.
Note that the True/False question type in a Lesson module is quite
different. It is effectively the same as the Multiple Choice question type in a
Lesson, but with only 2 responses. See Lesson_module#Multiple_choice.

Question set-up
 Select the question category
 Give the question a descriptive name - this allows you to identify it in
the question bank.
 Enter a question in the 'question text' field.
 Select an image to display if you want to add a picture to the
question. For the student, it appears immediately after the question
text and before the choices.
 Set the 'default question grade' (i.e. the maximum number of marks
for this question).
 Set the 'Penalty factor' (see Penalty factor below).
 Moodle 1.7+: If you wish, add general feedback. This is text that
appears to the student after he/she has answered the question.
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 Select the correct answer - true or false.

 Finally, provide feedback for each of the answers 'true' and 'false'.
 Click 'Save changes' to add the question to the category.

Penalty factor
The 'penalty factor' only applies when the question is used in a quiz using
adaptive mode - i.e. where the student is allowed multiple attempts at a
question even within the same attempt at the quiz. Then penalty factor for
a True/False question is always 1. If the student does not get it right first
time, they get no marks
See https://docs.moodle.org/35/en/True/False_question_type

Calculated question type
Calculated questions offer a way to create individual numerical questions by
the use of wildcards (i.e you can use common variables names as x, y
enclosed in curly braces to create the wildcards {x} and {y}) that are
substituted with random values when the quiz is taken.
For example, if you want to create a large number of "Calculate the area of
a rectangle" problems to drill your students, you could create a question
with two wildcards (i.e. {base}, {height} created from the common base,
height variable names) and put in the "Correct Answer Formula=" input field
{base} * {height} (* being the multiplication sign).
Correct Answer Formula= {base}*{height}
When a student takes the test, Moodle will randomly select values for
{base} and {height} and grade the response using the result of the Correct
Answer Formula.
The test will very rarely appear the same way twice.
See https://docs.moodle.org/35/en/Calculated_question_type

Simple calculated question type
Simple calculated questions offer a way to create individual numerical
questions whose response is the result of a numerical formula which
contain variable numerical values by the use of wildcards (i.e {x} , {y}) that
are substituted with random values when the quiz is taken.
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The simple calculated questions offers the most used features of the
calculated question with a much simpler creation interface.
See https://docs.moodle.org/35/en/Simple_calculated_question_type

Drag and drop into text question type
A drag and drop question type where missing words have to be dragged
into gaps in a paragraph of text.
See https://docs.moodle.org/35/en/Drag_and_drop_into_text_question_type

Drag and drop markers question type
This question type allows students to drop markers onto an area on a
background image. Drag and drop markers questions differ from Drag and
drop onto image question type in that there are no predefined areas on
the underlying image that are visible to the student.
See https://docs.moodle.org/35/en/Drag_and_drop_markers_question_type

Drag and drop onto image question type
This question type allows students to drag words, images or both from a
list and drop them into pre-defined gaps on a base image.
See
https://docs.moodle.org/35/en/Drag_and_drop_onto_image_question_type

Calculated multichoice question type
Calculated multichoice questions are like multichoice questions with the
additional property that the elements to select can include formula results
from numeric values that are selected randomly from a set when the quiz is
taken. They use the same wildcards than Calculated questions and their
wildcards can be shared with other Calculated multichoice or regular
Calculated questions.
See https://docs.moodle.org/35/en/Calculated_multichoice_question_type

Description question type
A Description question page simply shows some text (and possibly graphics)
without requiring an answer. It is more of a label than a question type.
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Essay question type

The essay question type provides the option of answering by uploading one
or more files and/or entering text online. (For longer essays, text or file
uploads, you may wish to consider using the Assignment activity rather than
this question type.)
Essay questions are created in the same way as other quiz question types.
The difference is that essay questions have to be marked manually, and the
student will not get a final grade until the teacher has marked their essay
See https://docs.moodle.org/35/en/Essay_question_type

Matching question type
Matching questions have a content area and a list of names or statements
which

must

be

correctly

matched

against

another

list

of

names

or

statements. For example "Match the Capital with the Country" with the two
lists "Canada, Italy, Japan" and "Ottawa, Rome, Tokyo". In the Quiz Module,
each match is equally weighted to contribute towards the grade for the
total question.
See https://docs.moodle.org/35/en/Matching_question_type

Random Short-Answer Matching question type
 From the student perspective, the Random Short-Answer Matching question
looks just like a Matching question. The difference is that the sub-questions
are drawn randomly from the Short Answer questions in the current
category (including or not subcategories from the current category).
 After an optional introduction, the respondent is presented with two or
more sub-questions, each with a drop-down menu box opposite listing the
same number (or fewer if several sub-questions have the same answer) of
available answer options.
 The respondent must select an answer option to match each sub-question.
 Each sub-question is equally weighted to contribute towards the grade for
the total question.
 The questions and answers are randomly drawn from the pool of shortanswer questions in the current category (and in its subcategories if this
option was selected).
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 You must make sure that the category contains enough short-answer
questions, otherwise the student will get an error message. The more shortanswer questions you add to the category, the more likely it is that
students will see a new selection on each attempt. Short answers questions
used in a previous attempt to the same question or in another Random
Short-Answer question of the same quiz are not excluded, so you should
ensure there are enough Short Answer questions in the category to mitigate
the risk of a student getting the same questions and answers.
 Note that the answer options are taken from the correct (having a 100%
grade) answers of each contributing short-answer question. If there are
several answers to the sort-answer question with a 100% grade, the first
one is used. Therefore, if the short-answer questions in this category are on
different topics, this question type will not be useful, as the correct option
will be obvious.
See
https://docs.moodle.org/35/en/Random_Short-Answer_Matching_question_type

Select missing words question type
This is very similar to the Drag and drop into text question type, but uses
drop-down menus in the text instead of drag-boxes. This works well where
the question text is very long and you would have to scroll a lot to do
drag and drop.
See https://docs.moodle.org/35/en/Select_missing_words_question_type

Short-Answer question type
In a short answer question, the student types in a word or phrase in
response to a question (that may include a image). Answers may or may
not be case sensitive. The answer could be a word or a phrase, but it must
match one of your acceptable answers exactly. It's a good idea to keep the
required answer as short as possible to avoid missing a correct answer
that's phrased differently.
The Quiz and Lesson modules both have short answer question types. The
analysis of the question given below works for both modules. However there
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is another analysis type available for Lesson which is not available in a
Quiz (see note below).
See https://docs.moodle.org/35/en/Short-Answer_question_type

Numerical question type
From the student perspective, a numerical question looks just like a shortanswer question. The difference is that numerical answers are allowed to
have an accepted error. This allows a fixed range of answers to be
evaluated as one answer.
For example, if the answer is 30 with an accepted error of 5, then any
number between 25 and 35 will be accepted as correct.
See https://docs.moodle.org/35/en/Numerical_question_type
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8. ADD USERS
Users may be added to a Moodle site in a number of ways. When user accounts
are created on a site, the process is called Authentication and when users join a
course, the process is called Enrolment. Normally only the administrator is allowed
to add users to a site. Course teachers are only able to add students to their
course and do not have permission to add users to the site. (If you're a teacher
looking for instructions on how to add students to your course, read Add
students.)
See https://docs.moodle.org/35/en/Add_users
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9. COURSE ENROLMENT
The process of adding students to courses is called Enrolment. This is different
from adding users to the site, which is known as Authentication. There are various
methods of enrolling students into courses, once they have logged in to Moodle.
A teacher can view, activate, add and remove the enrolment methods within their
course from the Enrolment methods link accessed either from the gear menu in
the nav drawer Participants link, or from the More link in the course gear menu
(or in Course administration > Users in the Administration block if you are using a
theme other than Boost). It may also be the case that the students are
automatically enrolled into the course by an administrative process, and the
teacher does not need to do anything.

Students enrol themselves
If Self enrolment is enabled then students can sign up to courses
themselves. The teacher can restrict enrolment to those who have been
given an Enrolment key and, if needed, a staff member may be given the
Keyholder role to manage enrolment keys.

Teachers manually enrol students
If Manual enrolment is enabled then teachers may add students to their
course from the nav drawer Participants link by clicking 'Enrolled users' in
the gear menu (or in Course administration > Users in the Administration
block if you are using a theme other than Boost).

Allowing guests into a course
Guests may be allowed to view course contents, but not participate in them,
if Guest access is enabled. To find out exactly what guests may and may
not do in a course, see the page Guest role.
See https://docs.moodle.org/35/en/Course_enrolment

Enrolment key
A course enrolment key is one method of restricting Self enrolment to a
smaller group. The default setting is not to set a key and allow anyone to
enrol themselves into the course.
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An enrolment key is often used as a simple method of having someone
else beside the teacher determine if a particular student can self enrol in
the course. The idea is that one or more people will supply the course key
to authorized people. Sometimes this distribution is private email, snail mail,
on the phone or even verbally in a face to face meetings such as a class
or counselor's office. Alternatively, a Keyholder role may be created and
assigned, then the text 'You should have received this enrolment key from...'
will be displayed when a student attempts to enrol.

Setting an enrolment key within a course
〉

In the course administration block, click Users > Enrolment methods

〉

Make sure self enrolment is enabled (has its eye open) and then click
the edit icon on the right.

〉

Add your enrolment key in the box provided. (Click Unmask to see what
you are typing.)

〉

Click the 'Save changes' button.

Setting a group enrolment key
〉

It is possible also to enrol students into the course and also directly
into groups by use of a group enrolment key.

〉

To do this, you first need to add the course enrolment key as in the
section above.
 If you do not set a master course enrolment key for the
course, then anyone can enrol without a key and users will not
be put into groups.
 Users in groups do not need to know the master course
enrolment key, only their own group enrolment key.
 Users not in a group can use the master course enrolment key
as usual

〉

Change the setting Use group enrolment keys to Yes

〉

Save the changes and then in the Course administration settings, click

Groups>Create groups
〉

Add an enrolment key to the group. This will be the key they type in
to access the course. (The course enrolment key is simply there to
keep others out)

Pag. 99

COURSE ENROLMENT

Pag. 100

Note: Be careful not to use the same enrolment key for more than one
group! A warning message will appear 'This enrolment key is already
used for another group.'
See https://docs.moodle.org/34/en/Enrolment_key

Unenrolment
Unenrolment is the process of removing users from a course. It is
controlled by one or more of the following:
 The enrolment duration, which suspends students after the specified
time has elapsed. Some plugins include the option to unenrol users
after enrolment expiration
 For Self enrolment, the 'Unenrol inactive after' setting in Course

administration > Users > Enrolment methods > Self enrolment can be
set to specify a time after which a student is automatically unenrolled
from a course if they haven't accessed it in that time
In addition, users with the appropriate permission can unenrol themself from
a course.
See https://docs.moodle.org/34/en/Unenrolment
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9.1 PARTICIPANTS
The Participants page enables teachers to easily enrol, view, search for, filter, edit
and delete course participants.

Enrolling users
Users may be enrolled from the Enrol users button at the top right and
bottom right of the screen.

Filtering and searching for users
The filter at the top left of the screen allows for filtering by period of
activity, enrolment method, group, role and status
It is possible to bulk select, edit and delete users who have self enrolled, in
a similar way to users who have been enrolled manually.

Roles
 To assign an enrolled user a role, click the pencil icon in the Roles column
then select the desired role and click the save icon to confirm the change.
 To remove a role assignment, click the delete icon (a cross) next to the
role name.
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 Only roles which can be assigned in the course context type are available
to select. The course context type may be set by an admin by editing the
role via Site administration > Users > Permissions > Define roles.
 Only roles which a user is allowed to assign are available to select.

Groups
To add a user to a group (requires at least one group to have been
created previously), click the pencil icon in the Groups column, select the
group and then click the save icon to confirm the change.
See https://docs.moodle.org/34/en/Participants
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10. TRACKING PROGRESS
There are several ways to track student progress in Moodle.

10.1 GRADES
Grades can be entered in multiple locations in Moodle. It will depend on what you
are grading where the best place is to enter the grades. There are advantages to
each area. Entering grades from the Assignment has the advantage that it will
send a notification to the student when the grade is submitted.
See https://docs.moodle.org/34/en/Grades

10.2 COMPETENCIES
Competencies describe the level of understanding or proficiency of a learner in
certain subject-related skills. Competency-based education (CBE), also known as
Competency-based

learning

or

Skills-based

learning,

refers

to

systems

of

assessment and grading where students demonstrate these competencies.
 Competencies may be enabled by an administrator in Site administration >

Competencies.
 Administrators can then set up competency frameworks and add competencies
to them
 They can then create learning plan templates, add competencies to them and
assign learning plans to individual selected students or to whole cohorts
 Teachers can add competencies to courses and course activities. They can
view a competency breakdown report from the Administration block and rate
competencies.
 Staff with the relevant capabilities can review student learning plans and view
any evidence of prior learning students submit
 Students can view their learning plans, upload evidence of prior learning and
request reviews.

Course competencies
•

A course teacher can list which of the competencies they will be teaching
in their course from the competencies link in the navigation drawer (in the
Boost theme) or from Navigation > My courses > 'Course name' >
Competencies. in other themes. A teacher can add or remove competencies
from a course here, and see which competencies have been linked to which
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•

activities. Clicking on the competency name will take the teacher to a
grading page for that competency.
A student can also see (but not change) the competencies linked to a
course from the navigation drawer (in Boost theme) or from Navigation >
My courses > 'Course name' > Competencies in other themes. They will also
see their current rating for each competency.

Manually rating course competencies
A course teacher can rate the students against each of the course competencies
from Course administration > Reports > Competency breakdown. Select a student
from the menu (1) and then click on the desired competency:

The page for that student will display and you
can then change their rating from the dropdown.

Pag. 104

Pag. 105

TRACKING PROGRESS

Activity competencies
Competencies can be linked to activities. This means you can make sure that you
have activities or resources for every competency in the course, by looking at the
course competencies page and finding un-mapped competencies.
It is possible to map more than one competency to an activity, by selecting more
than once from the competency drop down when setting up the activity.
It is possible to use activity completion to automatically complete - or add
evidence to course competencies.
To add a competency to an activity
 Edit the settings for the activity
 In the competencies section, select one or more competencies from the list
of course competencies
 If desired, set what to do upon activity completion - attach evidence, send
for review or complete the competency

The activity will then be shown under the competency on the course
competencies page

Course competency with linked activity
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Example of Activity completion with Activity competencies
A student must demonstrate a skill four times before reaching a competency:
 Create four activities (as four tasks) with the completion of the activity set to
receive a vote.
 Set up an evaluation step from the assignment settings screen.
 For tasks 2, 3 and 4, restrict access until the previous assignments have been
completed.
 In the assignment settings for the final assignment, expand "Skills of the
course", select the required competence and set "On completion of the
activity" to "Complete the competence".
 Studente The student submits the work normally. Teachers' grades work
normally.
If all four tasks get a positive vote, the competence is automatically reached.
See also
〉

Competency frameworks

〉

Learning plans

10.3 ACTIVITY COMPLETION
If Activity completion is enabled by the administrator and in the course
settings, teachers can indicate for each course item how they wish it to be
registered as complete. A tick/checkmark will then appear against the
activity. Students may either mark it complete manually or the item will
automatically be registered as complete once a student has met the
specified

criteria.

These

may

be

viewing

a

resource,

submitting

an

assignment, posting in a forum or other conditions. The teacher can see an
overview of who has completed what in the activity completion report in

Course administration > Reports > Activity completion.
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10.4 ACTIVITY SETTINGS
Depending

on

the

type

of

activity,

there

are

different

completion

requirements. For example, a Page might have the requirement to require

view; a Quiz might have the requirement to require grade while a Forum
might have the requirement to require posts/discussions/replies.

Completion tracking
There are three options:
 Do not indicate activity completion - this will not show checks (ticks)
next to the activity
 Students can manually mark the activity as completed - students
press the check (tick) to change it. (Note: they can do this even
without doing the activity!)
 Show activity as complete when conditions are met - the selected
completion criteria must be met before the check (tick) will change
style

Require view
When this option is ticked, students have to view the activity i.e. click the
link in order to complete it. You should not turn on the 'view' condition if
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you have other requirements - this makes extra work for the server and it's
unlikely that a student could meet any other conditions without viewing the
activity.

Require grade
When this option is ticked, students have to get a grade on the activity in
order to complete it. For example, a quiz would be marked completed as
soon as the user submits it (so long as it doesn't contain any "essay"
questions).
It does not matter how well the student did. Getting any grade will mark the
activity completed.

Setting a grade to pass for a quiz
It

is

possible

distinguish

to

between

'pass' and 'fail' grades
so

that

becomes

a

quiz

'completed,

passed' or 'completed,
not passed' instead of
just 'completed'. These
results show a different
icon
text

and
in

alternative
the

Activity

completion report.

To set this up, you need to specify the pass value for the quiz activity's
individual grade:
 Go to the Quiz settings and in the Grade section, locate the 'Grade
to pass' field.
 Enter a grade value (e.g. 5.0)
 Click the 'Save changes' button
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'Completed, passed' shows a green tick and 'Completed, not passed' shows
a red cross.
Once you have done this, anybody submitting the quiz will receive either
the pass or fail completion icon. If the quiz can be taken multiple times, the
completion icon will automatically update whenever the grade does.
There is one limitation: this only works if grades are immediately visible to
students. The grade must be neither permanently hidden, nor hidden until a
certain date. If a grade is hidden then only the standard 'completed' state
will be displayed - even once the hidden date has passed.

Require passing grade
If a grade to pass is set for the quiz then it will be marked complete
once the student obtains this grade.
If a certain number of attempts are allowed, the quiz may be marked
complete once the student has done them all (even if, for example,
they did not achieve the passing grade.)
Note that Require grade must be ticked as well as "Require passing
grade".

Lesson completion settings
The following settings are specific to the Lesson activity (in additon to the
standard ones)

Require end reached
In order for the lesson to be marked complete, the student must go
to the very last page of the lesson.

Require time spent
In order for the lesson to be marked complete, the student must stay
within the lesson pages for the time specified by the teacher here.
The time can range from seconds to weeks. If they finish the lesson
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sooner, they will see an alert saying they did not reach the minimum
time acceptable and may have to repeat the lesson.

Student message if the condition is not met.

Assignment completion settings
Student must submit to this activity to complete it
This setting means that an assignment may be considered as completed
once the student has submitted it but before the teacher has had time to
grade it.

Locked completion options
If at least one person has completed an activity, completion options are
'locked'. This is because changing these options may result in unexpected
behaviour. For example, if somebody has ticked an activity as manually
completed, and you then set it to automatic completion, the activity will
become unticked - very confusing for the student who had already ticked it!
Tip: It is best not to unlock options unless you are sure it won't cause problems for example, if you know that students don't have access to the course yet, so it
will only be staff who have marked the activity completed when testing.

What happens when you unlock
Once you unlock options and then click 'Save changes', all completion
information for the activity will be deleted and, if possible, regenerated
according to the new settings.
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 If the new completion option is manual, everyone will be set to 'not
completed' regardless of any previous setting.
 If it is automatic then, depending on the options chosen, the system
may or may not be able to construct a correct current value for
everyone.
•

The 'viewed' requirement will not work - even if a student has viewed
the activity before, it will not be marked completed until they view it
again.

•

Most other options will be recalculated successfully.

If you change completion options while a student is logged in, they may not
see the changes for some minutes.

10.5 USING ACTIVITY COMPLETION
 If this feature is enabled, it is a helpful way for students to be able to
track their progress in a course. The student has an easy to see checklist
of what they have done so far.
 It can also be linked to Course completion in order to allow both students
and teachers to watch progress through a course. As each activity is
checked

off

as

"complete",

the

student

moves

futher

towards

final

completion of the course.
 It can also be linked to Restrict access in order to allow the teacher to set
criteria upon which a student is allowed to progress through a course and
access materials.
 It is possible to edit default activity completion settings within a course and
to bulk update the settings for existing activities.

Activity completion icons
manual - not yet marked as complete
manual - enabled
manually completed
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automatically completed
automatically failed
automatic - not completed
automatically passed
automatic - enabled

The manual - enabled and automatic - enabled icons are used on the course
page when editing is turned on for teachers to see at a glance which activities
have manual completion and which have automatic completion.

Activity completion report
Activity completion info can be viewed by managers, teachers and non-editing
teachers (and any other users with the capability report/progress:view) in

Administration> Course administration> Reports > Activity completion.
Teachers can mark activities complete on behalf of students by clicking into the
relevant

completion

boxes.

This

requires

the

capability

Override

activity

completion status which is enabled for editing and non-editing teachers by
default.

10.6 COURSE COMPLETION
Course completion shows if a course has been completed. It can show the
progress a student is making towards finishing the course according to specific
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criteria. The criteria can include meeting an activity's grade level or a manual
checking "complete" by either the student and/or teacher. The report can also
show if the student has completed another course(s) that is marked as a
"completion dependent" course.
Course completion does not have a "restrict access" function. It is best thought of
as a report.

Enabling course completion
An administrator can enable course completion for the site by ticking the 'Enable
completion tracking' checkbox in Administration > Site administration > Advanced

features.
A teacher can then enable course completion for their course by setting 'Enable
completion tracking' to Yes in the Edit settings screen for their course. (This also
enables the use of Activity completion.)
A Course completion link will then appear in the gear menu or the navigation
block, depending on the theme. Clicking there will display three tabs:

See
〉

Course completion settings
https://docs.moodle.org/34/en/Course_completion_settings

〉

Using Course completion

10.7 BADGE
Badges can be awarded either manually or using activity completion settings in a
course and are a popular way to motivate students. Students may be awarded
badges at different stages of the course for different levels of progress
See
〉

Managing badges https://docs.moodle.org/34/en/Managing_badges

〉

Badges settings

〉

Using badges

Pag. 113

Pag. 114

INSIGHTS

11. INSIGHTS
11.1 UPLOAD LARGE FILES
Currently, in the portal https://learning.europeanregisterphlebologists.eu, it is
not possible to upload files with dimensions exceeding 16Mb, to overcome
this limit a cloud repository has been activated in which it is possible to
upload large files (even 1 Gb).
Once uploaded, they can be recalled via links within the course.
Below are the credentials and information needed to upload the files
(Access credentials will be communicated via e-mail.)

After logging in, the folders and files present are displayed. Please create a
folder with your last name in which to insert your files. The folder can be
created by clicking on the + icon at the top and then on "Folder".
Files can be uploaded by clicking on the + icon at the top and then
clicking on “Upload”
Each file uploaded to be "called" within the course must be shared.
To create the share click on the share icon (3 connected dots), then in the
right column select "Sharing" -> "Public Links" and then on "Create public link".
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A window will open, check that "Read Only" is selected and then click on
"Save" and leave the other input fields unchanged
To copy the link you just created, click on the "Copy to clipboard" icon (block
with arrow on the left)

Files uploaded to the Cloud can be recalled within the course via "File picker".
The file can be recalled in a lesson via links (see example in the Test lesson)
or by adding a new URL resource in the relevant section.

Pag. 115

Pag. 116

INSIGHTS

How to insert the newly created link in a lesson or web page.

11.2 EMBED A VIDEO
When you embed a video in Moodle, it is still stored on the video hosting site (e.g.
on YouTube or theBox), but you can view it directly in Moodle.
Including video elements in your course can bring life and movement to an
otherwise static page, and increase student engagement. Videos can be lectures,
interviews with experts, demonstrations, animated explanations of concepts etc.
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Upload a YouTube video (quick method)
This is the most straightforward method of inserting a YouTube video in a
course, but you cannot resize the video once it is uploaded.

1. Locate the relevant video on the YouTube website, and copy its URL.

2. In the text editor of
the page where you want to
embed the video, highlight the
link text and click the link icon.

3.
In the Insert/edit link
window, paste the URL into the Link
URL field and click Insert. The text will
display in the text editor as link text.
Click Save Changes.
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4. The video will be displayed in
the chosen location.

Embed a YouTube video (flexible method)
Teachers or students can use the following method:
1.
Go to the YouTube page for the relevant video.
At the bottom-right of the video frame, click Share.

2.
Options for sharing will display. Click
Embed. A popup box appears with some
options below it.

3.
If the standard embed size of
560 x 315 pixels is suitable for your
course purposes then go to step 4 below.
Otherwise, you can change the video size
by entering your preferred width and height
in the code as shown below. You can also
change several settings such as the
starting time under Embed options.
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4. Select all the code in the Embed Video box and Copy it.

5.

in Moodle, in the text editor, click the Edit HTML Source icon.

6. In the HTML Source Editor, click where you want the video to display,
and Paste in the embed code.
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7. Click Update and then Click Save.

Resize an embedded YouTube video
You can resize a YouTube video that you have embedded in a Moodle
course by following these instructions:
1.

In the text editor, click the Edit HTML Source icon

2. In the HTML Source Editor window, locate the HTML tags for width and
height. The numbers accompanying these tags indicate the current pixel
width and height of the video. Change these numbers to suit the size
you want, being careful to maintain the aspect ratio so that the video
does not become distorted.

3. Click Update.
4. Check that your video displays at the correct size.
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